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Chapter 1

Overview

Designed for developers and validators, the LeCroy Summit T28™ is a Gen1/Gen2 
PCI Express advanced verification system. 

By leveraging years of experience in protocol analysis tools for emerging markets, 
Summit T28 blends sophisticated functionality with practical features to speed the 
development of PCI Express™ IP cores, semiconductors, bridges, switches, add‐in boards, 
and systems.

PETracer Analyzer Hardware and Software

Features and Benefits

Summit T28 Analyzer has these features and benefits:

Features Benefits

Powerful and Intuitive 
CATC Trace™ Analysis 
Software

Faster interpretation and debug of PCI Express traffic 
with color‐coded, clearly labeled protocol elements in 
a graphical display.

Extensive Decoding Complete, accurate and reliable decoding of TLPs 
(Transaction Layer Packets), DLLPs (Data Link Layer 
Packets), and all PCI Express Primitives.

Intelligent Reporting Quickly identify and track error rates and abnormal 
link or timing conditions. Display configuration space 
and protocol specification details.

Sophisticated Viewing View Packet, Link and Split Transaction levels of the 
PCI Express protocol. Collapsible/expandable headers 
with Tool tip explanations make it easy to navigate 
and interpret packet contents, headers, and 
commands. View packets, transactions of TLPs and 
DLLPs in classic CATC Trace™ format or in raw 
bit stream for deeper analysis.

4 GB Recording Capacity, 
2 GB in each direction

Capture long recording sessions for analysis and 
problem solving.

Flexible Host Interface USB and GIGE.
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CATC Trace Software

Summit T28 utilizes the CATC Trace™ to assist users in analyzing how PCI Express 
components work together, diagnose problems, and test for interoperability and 
standards compliance. 

The CATC Trace is a powerful and intuitive expert software system embedding detailed 
knowledge of the protocol hierarchy and intricacies, as defined in the protocol 
specification. The software allows the user to control the Analyzer and set specific real‐
time triggering and filtering conditions. The CATC Trace utilizes a Windows‐based 
graphical display that has been optimized for fast and easy navigation through a captured 
traffic session. Users are alerted as violations are detected at all levels of the protocol 
layering and can easily drill down on areas of interest or collapse and hide fields that are 
not relevant. 

Downloadable CATC Trace 
Viewer

Share and annotate CATC Trace recordings within a 
development team. Freely distributable PETracer 
software enables collaborative analysis across sites 
and time zones.

Bidirectional x1‐x8,
2.5 GBps to 5.0 GBps
recording support

Accurate and non‐intrusive collection of PCI Express 
CATC Trace data.

Field‐upgradeable firmware 
and recording engine

Upgrades available for download direct from the 
LeCroy website.

Flexible probing options Supports a variety of probing options including slot 
interposers, MidBus probes and speciality probes.

Gen2 MidBus probe

Gen2 multi‐lead probe

Gen2 active interposer

External interface for probing 
and monitoring auxiliary 
digital signals

Enables cross triggering between other test 
instruments.

Dword to Transaction Level 
Viewer

View Dwords, Packet, Link and Split Transaction levels 
of the PCI Express protocol.
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PETracer Analyzer Hardware and Software  LeCroy Corporation

Summit T28 Analyzer

The LeCroy Summit T28 is LeCroy’s high performance PCI Express analyzer for customers 
in server, workstation, desktop, graphics, storage and network card markets.

Figure 1.1: Summit T28 Analyzer

With advanced features such as data rates from 2.5 to 5.0 GBps, lane widths from x1 to 
x8, and 4 GB of memory, the Summit T28 provides unmatched capability and flexibility for 
developers and users of advanced PCI Express products. The Summit T28 is the most 
advanced and sophisticated PCI Express Analyzer available in the market today.

As with other LeCroy PCI Express analyzers, the Summit T28 leverages the intuitive and 
powerful CATC Trace analysis software system, embedding a deep understanding of the 
PCI Express protocol hierarchy and intricacies. The colorful, intuitive and easy‐to‐use 
graphical display allows you to quickly capture and validate PCI Express product designs.

In addition to a full suite of advanced hardware and software features, the Summit T28 
has user‐convenience and analysis features, such as support for automatic 
“lane swizzling,” which allows a board developer to lay out a mid‐bus probe pad with 
lanes in non‐standard order, simplifying the design of the board. Internally, the 
Summit T28 maps the lanes back into their correct order and accurately displays the 
embedded bus traffic. An optional BitTracer™ mode allows bytes to be recorded as they 
come across the link, allowing debugging of PHY layer problems and combining the 
features of a logic analyzer format with a protocol analyzer format.

The Summit T28 supports USB and GIGE host interfaces. By connecting over GIGE, 
engineers can operate the system remotely (for example, install the client software on 
their desktop systems to control an analyzer operating in a remote lab). Also, multiple 
engineers working collaboratively can time‐share use of a single analyzer, reducing the 
need for an additional analyzer for each engineer and increasing the cost effectiveness of 
the product.



LeCroy Corporation PETracer Analyzer Hardware and Software

4 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual

Features

 Powerful and Intuitive CATC Trace Analysis Software System: The CATC Trace 
embeds deep understanding of the PCI Express protocol hierarchy and 
intricacies. This knowledge is presented in a colorful, intuitive and easy‐to‐use 
graphical display, allowing you to quickly capture and validate PCI Express 
product designs. 

 Protocol Hierarchical Viewing: Displays Packet, Transaction, and 
Split Transaction levels of the PCI Express protocol, with increased drill‐down 
detail for PCI Express primitives, errors, payloads or individual packets. 

 Lane‐Reversal Compatible: Triggers, records, and displays PCI Express traffic log‐
ically, regardless of the physical configuration of the lanes. 

 Statistical and Error Reporting: Provides a quick summary of the CATC Trace file 
to identify and track error rates and abnormal link or timing conditions. 

 BitTracer Recording Mode (optional): Records the bytes exactly as they come 
across the link, allowing debugging of PHY layer problems. 

 Auto Speed detection: Follows link transitions through speed changes.
 Automatic Lane Swizzling Support: Allows board developers to lay out lanes in a 

non‐standard order, simplifying board design. 
 Field‐upgradeable Firmware and Engine: Positions you to receive the latest 

PETracer enhancements and future additional capabilities. Allows field upgrades 
of all system types. 

 4‐GB Data Buffer: Capture long time windows for in‐depth analysis and 
identification of erratic problems. 

 USB connectivity: Allows connection by USB cable.
 CrossSync Application: The CrossSync application allows you to select analyzers 

for synchronization and manage the recording process.

Other Documents

For more information, refer to the following documents:

 LeCroy Analyzers File‐based Decoding Manual
 PETracer/Trainer Automation Manual
 PETracer VSE Manual
 CrossSync Control Panel User Manual
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Chapter 2

Hardware Description

The PCI Express™ system features Summit Analyzers.

System Components
 Summit T28™ analyzer system
 DC Power Adaptor, 12 volts, and AC power cable
 USB cable
 PETracer Software program CD‐ROM
 (optional) probes and interposers (see “Interposers and Probes” on page 10)

Host PC Requirements

The Summit T28 connects to a Host PC. Please consult the readme file on the installation 
CD for the latest PC requirements.
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Summit T28 Front Panel Description

When powered on, the Summit T28 activates the user‐accessible controls and LEDs on 
the front panel.

WARNING: Do not open the enclosure. There are no operator serviceable parts inside. 
Refer servicing to LeCroy.

The controls and LEDs are:

 Power LED: Lights when power is On.
 Status LED: Displays the connection status of the link.
 Trigger LED: Lights when Summit T28 triggers on an event.
 Upstream [7:0] connector: Connection to the probe for the capture of upstream 

direction of the link.
 Speed LEDs: Indicate speed setting the analyzer is using for Upstream direction.
 Ref Clk In (Reference Clock In) connector: Provides an optional alternative con‐

nection from an external reference clock source to the Summit T28 analyzer.
Note: In standard configuration, the Summit T28 analyzer uses the reference 
clock from a probe cable from the interposer.

 Downstream [7:0] connector: Connection to the probe for the capture of down‐
stream direction of the link.

 Speed LEDs: Indicate speed setting the analyzer is using for Downstream direc‐
tion.

Summit T28 Rear Panel Description

The Summit T28 rear panel contains:

 Trigger In and Out connector: Provide external trigger capabilities. You can con‐
figure Summit T28 to trigger external equipment using Trigger Out. You can use 
Trigger In to trigger the Analyzer from another device. 

 Sync In and Sync Out connector: Allow multiple Summit T28 analyzers to send 
synchronization and control messages to one another 

 USB Type B Host Computer connector: To connect the Analyzer to the Host PC 
using a USB connection. 

 DC IN connector: 12 V, 5 A
 Power Switch (black): 1 = On and 0 = Off.
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Chapter 3

Installation and Setup

The Summit T28™ is a standalone system.

You can begin PCI Express™ recordings after following the steps in this chapter. 

Installing the PETracer Software

PETracer software operates all of LeCroy’s PCI Express protocol Analyzer and Exerciser 
products:

The PETracer software is installed on a Microsoft® Windows®‐based PC and serves as the 
interface for the Exerciser and/or Analyzer.

To install the PETracer software on the Host PC: 

1. Insert the CD into the CD‐ROM drive of the PC that controls the Analyzer. The 
installation window opens and displays links to the PETracer software, user manuals, 
a readme file, and Acrobat Reader.

2. Select Install Software and follow the onscreen instructions.

The PETracer software installs automatically on the PC hard disk. During installation, 
all necessary drivers are loaded automatically.

3. To start the application, launch the PETracer program from the Start menu: 
Start > Programs > LeCroy > PETracer > LeCroy PETracer
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The PETracer program opens

Figure 3.2: LeCroy PETracer Application

Note:The software may be used with or without the Analyzer. When used without an Analyzer 
attached to the computer, the program functions as a CATC Trace Viewer to view, analyze, and 
print captured traffic. 
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Setting Up the Summit T28 Analyzer using a USB Connection

To set up the Analyzer using a USB connection: 

1. Connect the Analyzer to a 100‐volt to 240‐volt, 50 Hz to 60 Hz, 120 W power outlet 
using the provided power cord. 

2. Connect the USB port to a USB port on the PC using a USB cable.

3. Turn on the front power switch. 

Note:At power‐on, the Analyzer initializes and performs a self‐diagnosis. The results are reflected by 
messages on the Summit T28 LCD display. If the LCD display indicates failure, call 
LeCroy Customer Support for assistance. 

4. Follow the Microsoft® Windows® on‐screen Plug‐and‐Play instructions for the 
automatic installation of the Analyzer as a USB device on your analyzing PC. (The 
required USB drivers are installed on your system by the PETracer software 
installation.)

Click Finish when you see the message that says “Windows has finished installing 
the software that your new hardware requires” and the file has been installed in 
your PC. 
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Interposers and Probes

The Summit T28 works with Interposers and Probes. Some of them are listed below.

 Gen2 MidBus Probe: The Gen2 MidBus Probe is designed for use with the 
Summit T28 Analyzer and supports lane widths from x1 to x8 at data rates of 
2.5 GT/s (Gen1) or 5.0 GT/s (Gen2). 

 Gen2 Multi‐lead Probe: The Gen2 Multi‐lead Probe is designed for use with the 
Summit T28 Protocol Analyzer. The probe consists of 1 to 2 probe pods, which 
are connected to the analyzer using either iPass Y‐Cables (for x1 and x4) or 
straight x4‐to‐x8 iPass cables (for x8). Each probe pod supports up to 8 Flex Tips, 
with each Flex Tip connected via two coax cables.

 Gen2 Active Slot Interposer: The Gen2 Active Slot Interposer is designed for use 
with the Summit T28 Analyzer and supports lane widths from x1 to x8 at data 
rates of 2.5 GT/s (Gen1) or 5.0 GT/s (Gen2). For lane widths up to x8, one iPass Y‐
cable is required. 

Please refer to the Interposers and Probes for LeCroy PCI Express Systems datasheet at 
www.LeCroy.com for a comprehensive list.

The following sections describe how to set up probe systems.
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Using Interposers

Gen2 Active Interposer.

Figure 3.3: Connecting the Summit T28 Analyzer to the Device Under Test Using a 
Gen2 Active Interposer

Summit T28 Components

Summit T28 components used in the installation are:

 iPass Y‐Cable: The cable supports eight lanes from two directions. Side A of the 
probe cable connects to the Upstream port on the Analyzer (on the left in the 
photo above), and Side B of the probe cable connects to the Downstream port 
(on the right).

 Summit T28 x16 Slot Gen2 Active Interposer: The slot Interposer provides the 
point of attachment for the Analyzer to the Device Under Test (DUT). The Inter‐
poser is designed to fit between a motherboard and one of its device cards ‐ for 
example, a LAN card. The Interposer has three sets of connectors: a gold male 
connector that fits into a standard x16 PCI Express slot on a motherboard, a PCIe 
female connector that accepts a x16 PCI Express device, and two Interposer 
cable connectors that connect the Interposer to the Analyzer. 

Note:Edge reducers are required for lane widths less than x16.
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Installing the Gen2 Active Interposer

To install the Interposer, perform the following steps.

1. Insert the gold male connector on the Interposer probe into a x16 PCI Express slot in 
the motherboard. Use edge adaptors for x1, x4, and x8 slots.

2. Insert the PCI Express DUT into the Interposer’s PCIe female device connector. 

3. The slot Interposer is shipped from LeCroy with a metal face plate for attachment to 
a PC case. If you are working with a motherboard that is not in a PC case, you may 
prefer to remove the metal face plate so the Interposer can sit flat with the 
motherboard. To remove the face plate, unscrew the two screws that hold it onto 
the Interposer

Connecting the Probe Data Cable

x8 recordings require one cable. To connect a single Interposer data cable, connect the 
probe data cable to the Interposer card at [7:0]. Connect Side A of the probe cable to the 
Upstream [7:0] port on the Analyzer, and connect Side B of the probe cable to the 
Downstream [7:0] port.

Power On Analyzer and then DUT

1. Power on the Summit T28 Analyzer.

2. Power on the DUT.

3. Open the PETracer software on the PC host system. The Analyzer is now ready for 
PCI Express traffic recording.
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Using Probes

Example: Connecting the Summit T28 Analyzer to the Device Under Test Using a 
Gen2 MidBus Probe

Note:Mid‐bus probes require attachment‐pad and reference‐clock connections. For information 
about how to connect the attachment pad, reference clock, and cables in your system, see the 
MidBus Probe Manual. 

Components

Figure 3.4: iPass Y-cable

Figure 3.5: MidBus Probe pod

Figure 3.6: MidBus Probe Cable, Attachment Pad, and Header
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Figure 3.7: Clock Cable

Connections Overview for Gen2 MidBus Probe

Use a 1‐pod setup.

Use the iPass Y‐cables to connect the probe data connectors on the Analyzer to the 
MidBus pod(s). 

On the other side of the pod, connect the MidBus probe assembly.

Connect the header on the MidBus probe assembly to the MidBus footprint on the 
system under test (host platform/root complex). The following picture shows two midbus 
footprints, with one connected to the MidBus probe assembly.

Figure 3.8: Connect MidBus Probe to MidBus Footprint

Connection Procedure

To connect the Summit T28 to the system under test (host platform/root complex): 

1. Connect the MidBus pods to the Analyzer using the iPass Y‐cables.

2. Connect the MidBus probe assemblies to the MidBus pods.

3. Connect the MidBus probe assemblies to the MidBus footprints on the system 
under test. 

4. Connect external reference clock signal to Mid‐Bus External Clock In on Mid‐Bus 
probe pod, using external reference clock cable. 
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Example: Connecting the Summit T28 Analyzer to the Device Under Test Using a 
Gen2 Multi-lead Probe for x1 and x4

Components
 1 iPass Y‐cable for x1 and x4 (see “iPass Y‐cable” on page 13). 
 1 Multi‐lead Probe Pod for x1 and x4

Figure 3.9: Multi-Lead Probe Pod

 Up to 16 MidBus Probe SSMP Cables, and up to 8 Flexible Leads, per pod

Figure 3.10: Midbus Probe SSMP Cables

 1 Clock Cable (see Figure 3.7 on page 14).

Connections for Gen2 Multi-lead Probe

Overview

Use a 1‐pod setup.

For x1 or x4, use the iPass Y‐cable to connect the probe data connectors on the Analyzer 
to the pod(s). 

On the other side of the pod, connect the flexible lead tips.
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Connection Procedure

To connect Summit T28 to the system under test (host platform/root complex): 

1. Connect the pods to the Analyzer using the iPass Y‐cable cables.

2. Connect the flexible lead tips to the pods using the SSMP cables.

3. Connect the lead tips to the system under test by soldering to the trace. 
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Example: Connecting the Summit T28 Analyzer to the Device Under Test Using a 
Gen2 Multi-lead Probe for x8

Components
 2 iPass Straight cables for x8

Figure 3.11: iPass Straight Cables

 2 Multi‐lead Probe pods for x8
(See “1 Multi‐lead Probe Pod for x1 and x4” on page 15).

 Up to 16 MidBus Probe SSMP Cables, and up to 8 Flexible Leads, per pod.
(See Figure 3.9 on page 15).

 1 Clock Cable (see Figure 3.6 on page 13).

Connections Overview for Gen2 Multi-lead Probe

Use a 1‐pod setup.

For x8, use the straight iPass cable to connect the probe data connectors on the Analyzer 
to the pod(s). 

On the other side of the pod, connect the flexible lead tips.

Connection Procedure

To connect Summit T28 to the system under test (host platform/root complex): 

1. Connect the pods to the Analyzer using the straight iPass cables.

2. Connect the flexible lead tips to the pods using the SSMP cables.

3. Connect the lead tips to the system under test by soldering to the trace. 
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Chapter 4

Software Overview

The PETracer Software

The PETracer™ software administers Analyzer platforms and handles all CATC Trace 
analysis and display. The core software is thus the same for all of LeCroy's PCI Express 
products.

The software runs on a Windows® based PC that is attached to the Analyzer via a USB 2.0 
connection (USB 1.0 is also supported). PETracer software can be used without the 
Analyzer as a CATC Trace viewer for viewing, analyzing and printing traces.

The PETracer software operates in Microsoft® Windows® XP, Vista, and 7 environments.

Figure 4.1: Sample of a CATC Trace
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Application Layout

The PETracer application contains the following components:

Title bar: The title bar is at the top of the application window and displays the CATC Trace 
file name or generation script name.

Menu bar: The menu bar is located below the title bar, by default. The menu bar can be 
moved by clicking a blank area of the bar and then dragging the menu to a new position. 
It can be docked in another part of the application window or moved outside of the 
window to become a floating menu.

Toolbar: The toolbar is composed of buttons that represent the commonly used 
commands. The toolbar divides into smaller toolbars that can be moved and docked in a 
new position or made to float outside of the window.

Display area: The display area is the main part of the application window in which 
CATC Traces are displayed.

Status bar: The status bar is located at the bottom of the application window. The left 
end of the status bar displays descriptions of buttons and menu items when the mouse is 
positioned over them. The right end of the bar shows the search direction.

Using the Toolbar

You can use the PETracer application Toolbar as a shortcut to most of the operations 
supplied by the menus

Figure 4.2: Summit T3 Toolbar

Opens a previously recorded 
CATC Trace file.

Edit as text.
Script Editor. Opens a text editor for 
editing traffic generation files (*.peg)

Save As

Allows the open file to be 
saved with a new name.
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Using the Toolbar  LeCroy Corporation

Setup Recording Options

Opens the Recording 
Options dialog.

Setup Display Options
Opens the Display Options dialog.

Setup Generation Options
Opens the Generation 
Options dialog.

Start Recording. Repeat Upload.
Opens a dialog box that allows you to 
select a portion of memory to upload 
from memory, then causes the Analyzer 
to re‐send the CATC Trace from the 
Analyzer buffer to the host PC.

Stop Recording. Real Time Statistics monitor

Opens a window that displays real‐time 
information.

Manual Trigger
Click on this icon or press F5 
to trigger manually.

Disconnect/Connect Link. 
Click once to break and momentarily 
later restore link. Open menu to select 
either Connect or Disconnect.

Zoom in display. Wraps display information.

Zoom out display.

Hide Training Sequence. Hide Downstream traffic/recording.

Hide SKIP and Update FC 
packets.

Advanced Hiding Options

Opens a dialog box that allows you to 
select items to hide from view.

 Hide Upstream recording/
traffic.

Compact View

Toggles compacting of training 
sequences to analyze CATC Trace data 
faster, or no compacting to display more 
data.
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Find

Opens a dialog box that 
allows you to select one or 
more items to find in the 
recording, then searches to 
that point.

Find Next. Repeats last Find or Search 
action.

View Packet Level data. View Split Transaction Level data

View Link Transaction Level 
data.

View NVM Transaction Level data

File Information

Lists the conditions under 
which the recording was 
made.

Bus Utilization

Opens a window that graphically 
represents various information about 
the recording.

Error Report

Opens a window that lists all 
errors identified in the 
recording.

Link Tracker

Opens a window that displays symbol 
information per lane.

Traffic Summary

Opens a window that lists all 
events that occurred during 
the recording

Opens the Data Flow window.

Shows recorded data in a compressed 
tabular format.

Navigator. Shows/hides the 
Navigator bar ‐ a utility that 
lets you easily navigate the 
CATC Trace.

LTSSM Flow Graph
Shows a state diagram of the Link 
Training and Status State machine.

Displays the Data/Payload 
window for the current 
packet.

Displays the Packet Header bar.

Opens a window that displays the 
header information in the current 
packet, as it would be viewed in the 
specification.

Opens the Timing and Bus 
Usage Calculations window.

Running Verification Scripts

Opens a dialog that allows you to select 
and run verification scripts.
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Multi‐Segment Toolbar  LeCroy Corporation

Multi-Segment Toolbar

Toolbar Hide Buttons

The PETracer application toolbar has five buttons related to show/hide of CATC Trace file 
contents. The buttons allow you to quickly adjust the display to your needs.

 

Hide Training: Brings up a drop‐down menu that lets you to hide all or a portion of the 
packets in the training portion of the CATC Trace.

Hide SKIP, Hide EDS and Update FC: Brings up a drop‐down menu that lets you hide SKIP, 
Update FC and hide EDS packets in a CATC Trace.

Hide Upstream: Hide all traffic from endpoint devices to the root complex. 

First Segment. Open first 
segment in the 
multisegment CATC Trace.

Index file. This button becomes active if 
a multisegment CATC Trace file is open 
and displays the index file for the 
recording.

Previous segment. Open 
previous segment in the 
multisegment CATC Trace.

Next Segment. Open next segment in 
multisegment CATC Trace.

Last segment. Open last segment in 
multisegment CATC Trace.
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Hide Downstream: Hide all traffic from the root complex to endpoint devices.

Advanced Hiding Options: Brings up the Level Hiding pane of the Display Options 
window. Use this pane to tune the show/hide options within the CATC Trace display.

Figure 4.3: Display Options
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Using the Menus

The PETracer application main display includes the following set of pull‐down menus:

File Menu 

New PETrainer 
Script

Creates a new Traffic Generation file.

Open Opens a file.

Close Closes the current file.

Save as Saves all or a specified range of packets to a uniquely named file.

Convert Old 
Files

Convert CATC Trace files made in previous versions of PETracer to 
the new format for PETracer version 5.0 and higher.

Print Prints part or all of the current traffic data file.

Print Preview Produces an on‐screen preview before printing.

Print Setup Setup your current or new printer.

Edit Comment Create or edit the comment field in a CATC Trace file.

Export

>> to Text 

>> Packets to 
CSV Text

>> to 
Generator 
      File Format

Saves all or part of a CATC Trace to a text file or traffic generation 
file. This text file summarizes the traffic in the CATC Trace.

Saves the CATC Trace to a text file in Comma Separated Value (CSV) 
format.

Saves the CATC Trace to a generation file.

Exit Exit the PETracer application.
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Setup Menu

Record Menu

Display 
Options

Allows you to customize display options such as field colors, field 
formats and level hiding.

Recording 
Options

Allows you to customize control and setup features associated with 
recording, triggering, and filtering recorded events.

Generation 
Options

The Generation Options dialog is used to set configuration settings 
in a traffic generation script (*.peg). This dialog provides a 
convenient alternative means of editing a traffic generation file.

Generation 
Macros

Opens a dialog for creating buttons on the status bar that can be 
used to run traffic generation macros.

Update Device Opens a dialog box that lets you update the BusEngine™ and 
Firmware.

Calibrate 
Device

Opens a dialog box that lets you calibrate the BusEngine™ and 
Firmware.

Launch 
CrossSync 
Control Panel

Launches the CrossSync application. The CrossSync Control Panel 
allows you to select analyzers for synchronization and manage the 
recording process. See “CrossSync Control Panel” on page 43.

Analyzer 
Network

Displays the list of PCs with connected analyzers or exercisers that 
you want to use for recording or traffic generation.

All Connected 
Devices

Opens a dialog box with a list of locally or remotely connected 
devices. Allows you to update the BusEngine, Firmware, and your 
licensing information.

Start Causes the Analyzer to begin recording traffic.

Stop Causes the Analyzer to stop recording traffic.

Reupload Causes the Analyzer to re‐send all, or selected portions, of the CATC 
Trace from the Analyzer buffer to the host PC.

Disconnect/
Connect

Causes the Analyzer to momentarily break, and then establish the 
PCI Express link connection in both link directions.

Reset Link 
Configuration

Causes the Analyzer to reset the Serdes and thereby reset the 
Analyzers current link configuration. This command is needed when 
lane width or other lane settings are changed. Otherwise, the old 
link configuration is used and errors are generated in the CATC 
Trace.
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Report Menu

Report Menu operations are only available when you are working with a CATC Trace file.

File 
Information

Displays information about the file contents and describes the 
conditions of the file’s recording (Recording Options, hardware 
information, and so on).

Error Summary Displays an error summary of the current CATC Trace file and allows 
you to go to a specific packet, and save the error file to a uniquely 
named file.

Traffic 
Summary

Details the number and types of packets that were transferred 
during the recording. You can hide, save, send, text, print, and view.

Bus Utilization Opens a window with graphs of bus usage for the open CATC Trace.

Link Tracker Opens a window for displaying a detailed chronological view of 
traffic. The window provides view and navigation options.

Data Flow Opens the Data Flow Window, providing a tabular view of 
transactions and their payload.

Trace 
Navigator

Shows the Navigator bar for navigating a CATC Trace. Shows a 
snapshot of the recording and allows you to adjust the memory 
area for the view.

LTSSM Flow 
Graph

Shows a state diagram of bus activity. Also allows you to navigate 
through the LTSSM, based on the current recording.

Packet Header Opens the Packet Header bar, showing the Packet Header 
information as it would be viewed in the specification.

Packet Data Opens the Data Window for the current packet, with the options: 
Hide, Save, Hexadecimal, ASCII, Decimal, Binary, MSB Format, 
LSB Format, Big Endian, and Little Endian. Format Line allows you 
to enter the number of bytes, words, or dwords per line. 

Configuration 
Space

Presents a list of Configuration Spaces. Clicking an item displays the 
selected Configuration Space in a Configuration Table format.
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Search Menu

Search Menu operations are only available when you are working with a CATC Trace file.

Go to Trigger Repositions the display to show the first packet following the 
trigger event.

Go to Packet Repositions the display to a specific packet, Link Transaction, or 
Split Transaction number.

Go to Time Repositions the display to specific timestamp.

Go to Marker Repositions the display to a previously marked packet, Link 
Transaction, or Split Transaction.

Go to Allows searching for specific link events: TLP Type, DLLP Type, 
Ordered Set, Link Event, Traffic Class, DLLP Virtual Channel, 
TLP Virtual Channel, Direction, Speed, Link Width, Requester ID, 
Completer ID, Data Lengths, Errors.

Find Displays the Find dialog to allow searching for various events within 
a CATC Trace. You can search by Display Level: Packets, Link 
Transactions, Split Transactions. 

You can search packets by Event Group: TLP Type, TLP Header, 
TLP Requester ID, TLP Completer ID, TLP Data Pattern, 
TLP Data Lengths, TLP Tag, TLP Sequence Number, DLLP Type, 
DLLP Header, DLLP Virtual Channel, ACK/NAK Seq Number, 
Ordered Sets, Link Event, Direction, Errors. 

You can search link transactions by Event Group: TLP Type, 
Traffic Class, Virtual Channel,   Direction, Requester ID, 
Completer ID, Status, Tag. 

You can search split transactions by Event Group: TLP Type, 
Traffic Class, Virtual Channel,   Direction, Requester ID, 
Completer ID, Status, Tag. 

Find allows you to create complex searches based on numerous 
criteria.

Find Next Repeats the previous Find or Search operation.

Search 
Direction

Allows you to specify a forward or backward search of a CATC Trace 
file.
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View Menu

Toolbars>> Displays available toolbars: Standard, Frequently Used, Analysis, 
and Transaction Level. Use Customize to display the Windows 
Customize window.

Script Editor Displays the Script Editor (only appears if a .peg file is open).

Analyzer 
Network 
Chat Bar 

Opens a chat window for communicating with persons working 
with networked Analyzers. This command requires that your host 
PC be attached to a LAN. The Chat window broadcasts messages to 
whatever hosts have been connected to via the Analyzer Network 
command (under Setup in the menu).

Status Bar Switches display of the Status Bar on or off.

Real Time 
Statistics 

Opens the Real Time Statistics monitor dialog and displays a real‐
time graph of link activity.

Zoom In Zoom in increases the size of the displayed elements.

Zoom Out Zoom out decreases the size of the displayed elements.

Wrap Allows the display to wrap.

FC Credits Toggles a display for tracking Flow Control Credit update and 
consumption on a PCI Express link.

FC Credits 
Setup

Allows you to customize the display for tracking Flow Control 
Credits.

Compact View Toggles compacting of the Link Training sequence to analyze CATC 
Trace data faster or no compacting to display more data.

Packet Level View the current recording at the Packet Level.

Link 
Transaction 
Level

View the current recording at the Link Transaction Level.

Split 
Transaction 
Level

View the current recording at the Split Transaction Level.

NVM 
Transaction 
Level

View the current recording at the NVM Transaction Level.
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Tools Menu

Window Menu

Configuration 
Space Editor

Displays the Configuration Space Editor dialog which allows you to 
either create a new Configuration Space File or open an existing 
Configuration Space File.

Memory/IO 
Space Editor

Displays the Memory/IO Space Editor dialog which allows you to 
either create a new Address Space File or open an existing Address 
Space File. Select the memory size from the drop‐down menu.

TC to VC 
Mapping

Allows Traffic Classes to be mapped to Virtual Channels for 
purposes of simplifying navigation (for example, Search > Go to > 
TLP Virtual Channel) and changing the way the CATC Trace is 
displayed (for example, in Split Transactions).

Timing 
Calculations

Starts the mode‐less calculator dialog for calculating various timing 
and bandwidth parameters in the recording file.

NVM Base 
Address 
Mapping

Presents the dialog for the NVMHCI Base Address. This dialog 
displays the Device ID and whether or not the device is NVM.

Run 
Verification 
Scripts

Presents a list of verification scripts, from which you can run a 
verification script.

New Window Opens a copy of the current CATC Trace window.

Cascade Displays all open CATC Trace windows in an overlapping 
arrangement.

Tile Displays all open CATC Trace windows as a series of strips across the 
display.

Arrange Icons Arranges minimized CATC Trace windows at the bottom of the 
display.

Synchronize 
Traces

Synchronizes the CATC Trace View windows so that a move in one 
window repositions the other window of the same recording.
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Help Menu

Tool Tips

Tool tips provide details about fields within the CATC Trace. To see a tool tip, position your 
mouse pointer over a field within the CATC Trace.

You can turn off this capability in the Display Options menu.

Keyboard Shortcuts

User Manuals 
F1

Click User Manuals or press F1 to access the documentation guide 
for all LeCroy PCIe products. 

Register 
Product Online

Register at the LeCroy website registration page.

Check for 
Updates

Check whether a new software version is available. If so, you can 
download from the LeCroy web site. 
You can select to Check for updates at application startup

Display License 
Information

Opens an information box describing the current license 
information.

About Displays version information about the attached Analyzer and its 
Firmware and BusEngine™.

Keystrokes Operation

Ctrl + N New PETracer script

Ctrl+O Open file

Ctrl+P Print

Ctrl+S Save file

Ctrl + R Start Analyzer recording

Ctrl + T Stop Analyzer recording

Ctrl+Home Jump to first packet

Ctrl+End Jump to last packet

Ctrl + G Go to packet ...

Ctrl + F Search forward
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Status Bar

The Status Bar is a gray bar that runs along the bottom of the application window.

From left to right:

PETracer SN:309: Analyzer Serial Number

Ready: Analyzer Status

Recording Progress Bar: The colored bar to the right of the serial number represents how 
much traffic has been recorded. The trigger point is indicated by the black line at the left 
side of the bar. In this example, the trigger occurred at the very beginning of the 
CATC Trace. If the trigger is set in the middle of the CATC Trace, the line is positioned in 
the middle of the bar. Additionally, the color of the bar is different on each side of the 
trigger point. For examples, see “Recording Progress Bar” on page 32. The white strip 
along the top edge of the color bar indicates how much traffic has been uploaded from 
the Analyzer buffer to the host PC. 

Uploading and 20%: Indicates the Analyzer's recording status, what part of the recording 
process the Analyzer is now in. In this example, the Analyzer is in the upload stage and 
has completed 20% of the upload from the Analyzer to the PC. See “Recording Status” on 
page 33 for details on other status messages.

Activity: The colored bar moves to indicate that the Analyzer is currently recording.

Search: Fwd: Indicates search direction. The direction can be toggled to Search: Bwd by 
double‐clicking the search direction or by selecting Search Direction from the Search 
menu.

Recording Progress Bar

This indicator bar changes color to reflect the recording progress.

 Black vertical line is at the location of Trigger position.
 Black vertical line wiggles when Trigger Position is nearly reached.
 Field to right of Trigger Position changes color to indicate post‐trigger activity.
 Upper half of progress indicator turns white when recording is complete.

F1 Access documentation

F3 Find next

F6 Next pane

Shift+F6 Previous pane

Ctrl+B Search backward
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Recording Status

The second segment from the left in the Status Bar indicates recording status.

During recording, this status flashes one of the following messages:

 Trigger?
 Triggered!
 Uploading

After recording stops, the message changes to 

 Uploading data ‐ x% done (where x equals the percent that has been uploaded.)

As uploading progresses, the percent increases to 100. You can abort this upload if you 
wish by pressing the <escape> button on your keyboard or 

clicking in the Tool Bar.

Recording Activity

The third segment displays recorded activity. Activity is indicated in blue: 

Search Direction Indicator

The fourth segment in the status bar indicates search direction. The direction can be 
changed by selecting Search Direction from the Search menu.
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Making a PCI Express Recording
After connecting the Analyzer to the device(s), you must configure the 
Recording Options. Then you can test the Analyzer by creating a 16‐MB snapshot 
recording.

To make this recording, follow these steps:

1. From the Setup menu, select Recording Options.

2. Select the General tab. 

The following window displays the factory default settings in Simple Mode, such as 
Snapshot and 16‐MB buffer size. For your first recording, select proper speed and 
link width.

Figure 4.4: Summit T28 in Simple Recording Mode

3. In the Link section, specify the lane width of the PCI Express link to be analyzed. The 
rest of the settings in this section can be left at the factory defaults for most 
PCI Express systems. 

4. Click OK at the bottom of the Recording Options dialog to apply the Analyzer 
recording settings specified.

5. Click the Record button. 
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Stopping a Recording

You can stop the recording process at any time by pressing the Stop button . This 
causes the Analyzer to stop the recording and upload the CATC Trace to the host PC. If you 
press the Stop button again, the Analyzer temporarily halts the upload process and opens 
the following dialog box.

Figure 4.5: Abort Upload

This dialog presents options for stopping, continuing, or aborting the upload:

 Stop: Aborts further CATC Trace upload and displays whatever data that has 
already been uploaded.

 Continue: Resumes the upload. This command tells the Analyzer to finish 
uploading whatever CATC Trace data is still in its buffer.

 Flush: Flushes the CATC Trace without saving or displaying it.

If you allow the traffic data to be uploaded, it is automatically saved on the PC’s hard drive 
as a file named data.pex or the name you assign as the default filename in the recording 
options. 

Saving a Recording

1. To save a current recording for future reference, select Save As from the File menu.

2. Give the recording a unique name, then save it to the appropriate directory.
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Recording Multi-Segmented CATC Traces

If Save as Multisegment trace is enabled, PETracer divides the CATC Trace as it records it 
into segments and stores them on the host's hard drive. 

This option is useful for very large recordings and for host PCs with limited memory. In 
the latter case, multi‐segmenting gives a PC with limited memory a way to open 
recordings that are otherwise too large to open. 

The only downside to multi‐segmenting is that limits the scope of reports such as 
Traffic Summary, Bus Utilization, and Error Summary to each of the segments. You cannot 
perform summary statistics on the full recording.

The default segment size is 10 MB. Before attempting large recordings, it is 
recommended that you play with this number to see what value best suits your needs. 

How to Create a Multisegment Recording

To create a Multisegment recording:

1. Select Setup > Recording Options to open the Recording Options dialog at the 
General tab. Click Switch to Advanced Mode.

2. Check the box marked Save as Multisegment trace.

3. In the box marked MB Segments, enter a value of 4 to 128 MB. 

What Gets Created

Multisegmenting produces an index file and segmented CATC Trace files. The default 
name of the index file is data.pem. 

The index file and the segmented CATC Trace files are stored in a directory named after 
the index file. The directory is named data_pem_files. Below this directory additional, 
sequentially numbered sub‐directories (up to 100,000) hold the segmented CATC Trace 
files. These sub‐directories bear simple numerical names: 00000 to 00999. Each of these 
subdirectories can hold up to 100 sequentially numbered segment files. Collectively, the 
entire directory structure can hold up to 10 million files.
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Example

If you create a 1010 MB recording using 10 MB segments, the following files and sub‐
directories are created:

data.pem (This is the index file.)
data_pem_files\00000\segment_00000.pex
data_pem_files\00000\segment_00001.pex
...
data_pem_files\00000\segment_00099.pex
data_pem_files\00001\segment_00100.pex
data_pem_files\00001\segment_00101.pex

Note:An additional index file is created called segments.col. This is an internal system file 
that users should not modify.

PETracer Files

The PETracer software creates and uses different kinds of files:

 CATC Trace Files: Recorded traffic
 Recording Options Files: Configuration file that contains the various options 

selected in the Recording Options dialog to configure the recording
 Display Options Files: Configuration file that contains the options selected in the 

Display Options dialog to configure how traffic is displayed

CATC Trace Files

PETracer records PCI Express traffic into a CATC Trace file with the default name data.pex 
or any other that you specified in the Recording Options. This file is overwritten with new 
data each time PCI Express traffic is recorded. 

When Multisegment CATC Traces are created, a special index file is also created called 
<filename>.pem. This index file provides a high level view of the CATC Trace segments 
created in the recording session. 

If you want to save a CATC Trace, use the File > Save As function. This option allows you to 
save the current CATC Trace to a unique file name, thereby ensuring that it is not 
overwritten. This option also allows you to save a range of packets in a CATC Trace file.

You can pre‐define the name of the recorded CATC Trace file using the Trace Filename and 
Path option in Recording Options. 

Recording Options Files

Recording Options files are created when you set recording options. These files use the 
.rec extension and contain recording option information. 
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Display Options Files

Display Options files are created when you set display options. These files use the .opt 
extension and contain the display options information.

Opening CATC Trace Files

To open an existing CATC Trace file, click File > Open or .

If the file was made in a previous version of PETracer, the application presents the 
Convert dialog.

Figure 4.6: Convert Dialog

You must convert CATC Trace files made in previous versions of PETracer for them to open 
in PETracer version 5.0 or higher. The converted file has all the information that was in 
the original file.

You can:

 Convert & Backup old file: Convert the file, open it in PETracer version 5.0 or 
higher, and save it with the original name. Save the original file with the same 
name plus the extension .bak.

 Convert: Convert the file, open it in PETracer version 5.0 or higher, and save it 
with the original name. 

Note:After you convert a CATC Trace file, you cannot open the converted file in a 
previous PETracer version. 
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Saving CATC Trace Files  LeCroy Corporation

Saving CATC Trace Files

This section describes how to save a CATC trace file.

Using the Save As Function

When you record a CATC Trace file, the Analyzer software provides a pre‐defined name to 
the CATC Trace file (data.pex or any other that you specified in the Recording Options). If 
you do consecutive recordings, each time the previous recording is overwritten. If you see 
a recording you want to analyze later, you need to give a unique name to the CATC Trace 
file, so it is not overwritten with the next recording.

Also, when you analyze a recorded CATC Trace file, you might be interested in preserving 
just a part of the PCI Express traffic that was recorded. If you save a portion of a CATC 
Trace file, it can get significantly smaller, allowing you to attach it to an e‐mail.

To save a portion of a CATC Trace file or the whole file to a unique name, select Save As 
from the File menu.

Figure 4.7: File Save As Dialog

If you want to give a unique name to the CATC Trace file, select the All option and keep 
Rename original file checked. This is the default setting for the dialog.



LeCroy Corporation Exporting a CATC Trace File

40 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual

Saving a Portion of a CATC Trace

If you want to save a portion of a CATC Trace file, select Save packet range. Enter starting 
and ending packet numbers in the From Packet and To Packet fields. By default, it has the 
numbers of the first and the last packets in the file. The software is going to save all the 
packets in specified range to the new file, unless you have Do not save hidden packets 
checked. In this case it is going to save all packets in the range, EXCLUDING the currently 
hidden packets.

Exporting a CATC Trace File

By default, PETracer saves CATC Trace files in the .pex format. However, you can export a 
CATC Trace to a file in any of the following other formats: 

 Text
 Comma Separated Value (CSV)
 Generator file format

Exporting to Generator file format is a simple way to create a script file from your 
CATC Trace.

To export a CATC Trace file, select File > Export

Figure 4.8: Exporting a File
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Printing Data Files

To print all or part of the open CATC Trace:

1. Select File > Print from the menu or 

click the Printer button on the toolbar. 

The Print Packets dialog opens

Figure 4.9: Print Packets Dialog

2. To select a range of packets, enter values in the From packet # and To packet # fields 
and click Print. 

3. To print an entire file, leave the From and To fields empty and click Print.

The specified traffic information is printed as currently displayed, in color or gray scale as 
supported by your printer. Any CATC Trace File comments you entered are printed 
following the current document name at the top of each page. 

Note:CATC Trace File comments can be created by using Edit Comment on the File menu.
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Analyzer Chat Window

PETracer has a Chat window that allows you to communicate with users on remote PCs. 
For Chat to work, two conditions must be met:

 The PC hosts must have PETracer software installed and running.
 The hosts must be listed in each other's Network Browse list. This means that 

your PC must have the remote PC listed in its Network Browse window and the 
remote PC must have your PC listed in its Network Browse window.

Figure 4.10: Analyzer Network Dialog

If the above conditions are met, a Chat session is initiated by running the command: 
View > Analyzer Network Chat Bar. The following dialog box opens.

Figure 4.11: Analyzer Network Chat Dialog

Enter some text, then press Send. The message is then broadcast to all host PCs listed in 
your network browse window. If a target PC also lists your PC in its Network Browse 
window, then it can receive your message. When the message arrives, the Chat window 
automatically opens.
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CrossSync Control Panel

The CrossSync Control Panel allows you to select analyzers for synchronization and 
manage the recording process.

Launching the CrossSync Control Panel

To launch CrossSync from the PETracer PCI Express Protocol Analyzer software 
application, select the ‘Launch CrossSync Control Panel‘ entry in the ‘Setup’ menu (see 
the screen below). Or, you can launch CrossSync from the ‘Start’ menu.

Figure 4.12: Launching CrossSync from the PETracer PCI Express Protocol Analyzer Application

Please refer to the CrossSync Control Panel User Manual for more information.
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Chapter 5

Recording Options

Recording Overview

After installing the software recording options should be set prior to recording. The 
recording options define the behavior of the Summit T28 during recording. You can create, 
save and load previously saved recordings. This section explains how to define recording 
options on the Summit T28 Analyzer.

General Tab

The Recording Options dialog is used to configure a recording. 

To open the Recording Options window, click or select the command 
Setup > Recording Options.

Note:There are separate sets of Recording Options for each Analyzer type. To set the Analyzer type, 
select the appropriate platform from the Target Analyzer menu in the General tab of the 
Recording Options. 

The General tab displays options that affect all recordings (see Figure 5.1 on page 46). 
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Recording Options-General Tab

This section describes the General Tab recording options.

Figure 5.1: Summit T28 in Recording Options

Note:Please refer to the figure callout numbers in each of the sections below to co‐relate to Figure 5.1 
shown above. For instance, for Simple and Advanced Mode, see Figure 5.1: 1B.
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Simple and Advanced Mode  LeCroy Corporation

Simple and Advanced Mode

The recording options can be defined in Simple or Advanced modes. The Simple 
Recording and Advanced Recording options are the same in functionality, only the 
interface displayed is different. The Simple Mode allows quick access to commonly used 
options. The recording options are the same in both modes (See Figure 5.1: 1B).

Clicking on the Switch to Simple Mode toggles you between Simple and Advanced Mode 
(see Figure 5.2 on page 47).

Figure 5.2: Switch to Simple Mode Button

Trace Filename and Path

The Trace Filename and Path button sets the path and CATC Trace name for the recording. 
It allows you to change the default file name and path for the recorded CATC Trace file. 
The pre‐defined name is data.pex. See Figure 5.1: 1A

1. Select the Recording File Name button.

2. The Specify Trace File Name dialog opens to navigate to the directory you want.

3. Enter the new file name in the File name field.

4. Click the Save button.

This action does not do any immediate save operation. It just changes the default 
name and uses it in subsequent recordings.
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Saving and Loading Previously Saved Recording Options

You can save a recording or load previously saved recordings. In the general tab the 
following Save options are available (see Figure 5.1).

Setting Default Recording Options

To save the current recording options into the default Recording Options file:

Click Save As Default. The default file for the options is default.rec. 

When the PETracer software begins execution, it automatically loads the default.rec file, 
if one exists.

Options Name: See Figure 5.1: 1F

The Options Name is a descriptive, supplemental label that you can assign to a Recording 
Options file so you can easily recall what settings are in the Recording Options file. 

For example, if your Recording Options file were named StandardSettings.rec, your 
Options Name could be a long descriptive label such as Standard Record Options used 
for all normal Recordings.

Save: See Figure 5.1: 1C

Saves the current options to whatever file name you provide.

Save As Default: See Figure 5.1: 1D

Saves the current options into the default options file. This file is called default.rec or any 
other name you have assigned to the default options file. Whenever the LeCroy PETracer 
software begins execution, it automatically loads the default file, if one exists.

Load: See Figure 5.1: 1E

Loads a previously saved set of recording options.

OK

Applies changes and closes the Recording Options dialog.

Cancel

Cancels changes and closes the Recording Options dialog.

Loading Recording Options

In the Recording Options menu, you can load a previously saved recording options file.

To load Recording Options:

1. Select Setup > Recording Options from the menu.

2. Click the Load button from the Recording Options dialog. The Load dialog opens and 
lists previously saved options files (*.rec). 

3. Select a file and click OK. The options file loads.
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Recording Type  LeCroy Corporation

Saving Recording Options

Recording Options settings can be saved and later reused. Recording options settings are 
stored in *.rec files. 

1. Open the Recording Options dialog by selecting Setup > Recording Options.

2. Set your options, then click Save. 

3. Enter a unique file name. The .rec extension is added by default.(optional) To add a 
descriptive label to this file to help you remember what options were set, use the 
Options Name box.

Recording Type

Recording Type allows you to specify the type of recording you want to make (See Figure 
5.1: 2A). They are

 Snapshot
 Manual Trigger
 Event Trigger
 Bit Tracer Recording

Snapshot

A recording of a pre‐determined length. You set the recording length in the Buffer Size 
box. Recording begins when you click the Rec button on the toolbar and ends when the 
selected buffer size is filled or when you press the Stop button.

Manual Trigger

A recording that switches between the pre‐trigger buffer and the post‐trigger buffer 
when a Trigger is received. Recording begins when you select Start in the application. 
Recording continues until the post‐trigger buffer has been filled. You can also end the 
recording by pressing the Stop button in the application.

Event Trigger

A recording that switches between the pre‐trigger buffer and the post‐trigger buffer 
when it is triggered by an event in the CATC Trace. An Event Trigger begins when you 
select Start in the application and ends when the specified triggering event occurs in the 
CATC Trace or you press Stop. If an event triggers the end of the recording, the Analyzer 
records a predefined amount of post‐trigger data (specified by Trigger Position and Buffer 
Size.)

You can also terminate an Event Trigger recording by pressing the Manual Trigger button 
on the front of the Analyzer. When the Manual Trigger button is pressed, the Analyzer 
continues to record until the specified post‐trigger buffer has been filled.
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BitTracer Recording

See the next chapter, “BitTracer Recording” on page 111.

Buffer Size

The Buffer Size allows the Analyzer to record traffic to its buffer and then upload the 
CATC Trace to the host PC. Recordings are limited in size to the size of the Analyzer's 
buffer, see Figure 5.1: 2B (2 GB per direction, Upstream and Downstream).

The Buffer Size slide‐bar allows you to set the size of the recording buffer.

Figure 5.3: Buffer Size Slide Bar

The size selection is per direction. For example, selecting 32 MB creates two memory 
areas of that size.

After you have set the Buffer Size, you must set the Recording type and Trigger position 
options. These options determine how the buffer is used.

Note:The Buffer Size slide‐bar does not precisely portray the buffer size because of the way the 
packets are stored in the Analyzer’s memory.

Upload Size

Causes the Analyzer to upload a portion of the Analyzer's buffer. This option lets you look 
at part of the CATC Trace. Half of the uploaded CATC Trace is pre‐buffer and half post‐
trigger (See Figure 5.1: 2C).

Figure 5.4: Upload Size Slide Bar
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Misc

Turns on trigger beep, allows external interface signals to be saved into the CATC Trace, 
and tells the Analyzer to use whatever TC to VC mapping was used in the last recording. 
Click on the Default TC to VC mapping to manually map the Traffic Classes to 
Virtual Channels (See Figure 5.1: 2D).

Allows you to specify the following parameters for recording and uploading traffic.

Figure 5.5: Misc Section in Recording Options

 Beep When Trigger Occurs: Causes the host PC to beep when a trigger event is 
detected.

 Save External Interface Signals: If selected, causes the Analyzer to save signals 
from a Breakout Board as fields in the CATC Trace.

 Preserve TC to VC mapping across the channels: Causes the Analyzer to use 
whatever TC (Traffic Classes) to VC (Virtual Channel) mapping it established in 
the last recording (to re‐use previously discovered Configuration Space data) in 
all future recordings. 

 Default TC to VC mapping button: Lets users manually configure the default 
mapping.

Figure 5.6: Default TC to VC Mapping
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Target Analyzer

The recording options available on each analyzer are different and you should select the 
correct Target Analyzer to define it for the specific analyzer. As shown in Figure 5.1 on 
page 46 the Summit T28 Analyzer is selected and the recording options available for it are 
displayed (See Figure 5.1: 2E).

Target Analyzer presents a menu with these choices: 

 Edge T1‐4: Displays the options for the Edge T1‐4 Analyzer.
 PETracer ML: Displays the options for the PETracer ML Analyzer.
 PETracer ML (2 Units): Displays the same options as PETracer ML but lists Unit 1 

and Unit 2 in the Link Section on the right. In a two‐unit setup, Unit 1 and Unit 2 
are two separate Analyzers linked together by BNC on the back of the units to 
form a single, logical Analyzer.

 PETracer EML: Displays the options for the PETracer EML Analyzer.
 PETracer Summit: Displays the options for the PETracer Summit Analyzer.
 Summit T3‐8: Displays the options for the Summit T3‐8 Analyzer.
 Summit T28: Displays the options for the Summit T28 Analyzer.

Trigger Position

This Trigger Position slide‐bar lets you adjust the amount of recording buffer allocated to 
recording pre‐trigger and post‐trigger traffic (See Figure 5.1: 2F).

Figure 5.7: Trigger Position Slide Bar

For example, if you set the Trigger Position to 90% Post‐Triggering Traffic, the Analyzer 
records 10% pre‐trigger traffic and 90% post‐trigger traffic. 

Trigger Position is only available when Manual Trigger or Event Trigger is selected.
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Save As MultiSegment Trace

Divides the recording into segments so as to allow very large recordings to easily upload 
and view. If you are planning to create a large recording, you might want to test this 
option to see how it affects performance. Large CATC Trace files are easier to navigate but 
slower to open (See Figure 5.1: 2G).

In Advanced Mode this option allows the Analyzer to segment the CATC Trace into 4 MB 
to 128 MB files and to create an index file that summarizes the starting and finishing 
frame for each segment.

Figure 5.8: Save As MultiSegment Trace

The index file has a default name of data.pem.

The index file and segmented CATC Trace files are stored in a directory named 
data_pem_files. The directory is named after the index file. Below this directory 
additional, sequentially numbered sub‐directories (up to 10,000) hold the segmented 
CATC Trace files. These sub‐directories bear simple numerical names: 00000 to 00999. 
Each of these subdirectories can hold up to 100 sequentially numbered segment files. 

Example

A 1010 MB recording using the default file names creates the following sub‐directories 
and files:

data.pem (This is the index file.)
data_pem_files\00000\segment_00000.pex
data_pem_files\00000\segment_00001.pex
...
data_pem_files\00000\segment_00099.pex
data_pem_files\00001\segment_00100.pex
data_pem_files\00001\segment_00101.pex

The index file looks something like a CATC Trace file but contains packet‐like entities that 
summarize each segment. 

Viewing Multisegmented Files

If Save As MultiSegment Trace is enabled in the General tab of the Recording Options, the 
PETracer divides the CATC Trace into segments and stores them on the host's hard drive. 
Segment size is set in the MB Segments box. Enter a value from 4 MB to 128 MB. 

PETracer also creates an index file that provides a brief summary of each segment and 
hyperlinks to each of the segments. Double‐clicking a segment summary in the index file 
causes PETracer to open that segment. 

You can also navigate through the segments by clicking the buttons on the Multisegment 
toolbar.
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Link Settings

The Link options panel allows you to manage links. You can define the basic link 
parameters or leave it on Auto detect. The various link settings are described in this 
section (See Figure 5.1: 3).

Figure 5.9: Link Options for Summit T28

Speed

The Speed can be set at Auto, 5.0 GT/s, or 2.5 GT/s from the drop‐down menu. The 
default is Auto (See Figure 5.1: 3A).

Auto: When set to Auto, the hardware auto‐determines the speed.

5.0 GT/s or 2.5 GT/s: When set to a specific speed, LeCroy’s software forces the hardware 
to record at that speed.
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Link Width 

The Link Width sets the physical width of the link. Select the Link Width or select Auto 
(See Figure 5.1: 3B).

Upstream and Downstream

Gives you low‐level control over each link direction. The heading for these boxes indicates 
the port and/or unit to which the following options are applied based on the current 
Analyzer configuration (See Figure 5.1: 3C and 3D).

 Inhibit Channel: Do not record/upload this channel
 Reverse Lanes: If Swizzling Config is set, the Reverse Lanes will not work if Auto 

is checked.
 Invert Polarity 

Reference Clock

If the PCI Express link under analysis uses spread‐spectrum clocking, then the Analyzer 
must use the external reference clock from the system. If the Device Under Test does not 
supply a reference clock, the internal reference clock in the Analyzer module can be used 
instead (See Figure 5.1: 3E).

SMA Clock

For SMA Clock, both inputs must be connected to a clock.

Disable Descrambling

If checked, causes the Analyzer to assume that none of the PCI Express traffic is 
scrambled. By default, the Analyzer determines the scrambling state of the devices under 
test (See Figure 5.1: 3F).

Auto-Configure Lane Polarity

Lets the Analyzer determine lane polarity (See Figure 5.1: 3G). 
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Swizzling Config...

The Swizzling Config dialog allows you to reconfigure the order of the US (UpStream) and 
DS (DownStream) lanes. 

Check the box to Auto‐Configure Lane Swizzle (See Figure 5.1: 3H). Note: Autoswizzle 
works only when the analyzer sees LTSSM Configuration state link training sequence.

Figure 5.10: Swizzling Config Dialog

When the Auto‐Configure Lane Swizzle is checked, it is important to configure Lane 0. You 
can do so by manually dragging Lane 0 to the required position. See Figure 5.11.

Figure 5.11: Manually Configuring Lane 0 when Auto-Configure Lane Swizzle is Checked

Manually moving Lane 0 to the 
required position
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Triggering

Triggering Options can be set in both Simple and Advanced Modes. The options in both 
modes are the same, only the GUI is different where shortcuts for the events are 
displayed in the Simple Mode for easy access (see Figure 5.2 on page 47).

In the Advanced Mode triggering is set up via the recording rules which allow greater 
flexibility to create advanced sequences you would like the analyzer to look for. These 
recording rules are not available in the Simple Mode. The Simple Mode allows you to 
simply define triggering by checking the boxes. 

Note:Ensure that the correct analyzer is selected for the right options.

Triggering On (Simple Mode)

You can check any of the boxes shown in Table 5.1 for Trigger On in Simple Mode (see 
Figure 5.12 on page 58). 

Trigger Position is only available when Event Trigger or Bit Tracer Recording is selected.

Note: If you check 2 boxes or more the triggering will occur based on an OR condition, not AND 
condition.

TABLE 5.1:  Simple Mode Trigger On Events

Enter Elec Idle AnyTLP

Exit Elec Idle Config

Switch to G1 Memory

Switch to G2 IO

Switch to G3 Message

TS1 RD Error

TS2 Invalid Symbol

InitFC1 Block Align Error

NAK Token Error

PM Idle Symbol Error
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Figure 5.12: Simple Mode Triggering Options
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Triggering On (Advanced Mode)

The same triggering options are available in the Advanced Mode as in the Simple Mode. 
The Advanced Mode gives you additional flexibility to drill down and configure these 
options in greater detail via the Recording Rules dialog. 

In the Advanced mode click on the Recording Rules tab to configure the settings. As 
shown in Figure 5.13, the Recording Rules tab allows you to create New Events. For each 
event you can create Actions. A detailed explanation of the Recording Rules is given in the 
following sections.

Figure 5.13: Recording Rules Tab

New Events Menu Available Events Panel Toolbar

Global 
State 
Cell

Sequence 
Cells

Actions 
Menu

Main 
Display 
Area
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Recording Rules Overview

The Recording Rules allows you to specify complex triggering and filtering options. The 
Summit T28 monitors incoming traffic and looks for specified events. It performs actions 
like triggering and filtering. Complex options can be created by putting Events in a 
sequence.

Events are based on Resources. Resources are explained in the next section.

Resources

Events in Recording Rules are based on Resources. There are two types of Resources. 
They are Packet Match Resources and Basic Resources.

Packet Match Resource

Packet Match Resources are for the DLLP and TLP events. A Packet Match Resource allows 
you to define not only packets but it also allows you to define each specific bit in a packet. 
In the Packet Match resource you can define the exact layout to the bit level so that the 
Analyzer can match the exact pattern that applies to a DLLP or TLP event.

To set a Packet Match Resource, click on the New Event button and select any of the 
options. In this case we have selected DLLP: InitFC1. The DLLP: InitFC1 displays in the 
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Available Events panel. Double‐click on the DLLP: InitFC1 to select the specific fields and 
go to the Layout tab to change the pre‐defined bits (see Figure 5.14).

Figure 5.14: Setting Up a Packet Match Resource
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Basic Resource

Basic Resources are for the Link States, Ordered Sets and Errors. A Basic Resource does 
not allow you to define patterns to the bit level. It just matches events that have been 
predefined.

To set a Basic Resource, click on the New Event button and select any of the options. In 
this case we have selected Ordered Set: TS1. The TS1 displays in the Available Events 
panel. Double‐click on the TS1 to select other Ordered Set events and go to the Actions 
tab to configure specific Actions (see Figure 5.15).

Figure 5.15: Setting Up a Basic Resource
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Global State and Sequence States

The Main Display area in the center of the Recording Rules window has two cells that 
affect events differently, they are the Global State and Sequence State. 

Figure 5.16: Global State Cell and Sequence State Cell

In the Global and Sequence State you can add events by clicking on the New Event button 
and after the event is in the State you can right‐click to Specify Actions, Move, Copy or 
Delete the event. You can view the Properties dialog to make additional changes to the 
Property of the event (see Figure 5.13). The description of these actions are given in 
Table 5.4 on page 74. 

Figure 5.17: Global State Menu
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Global State

The Global State is active all the time. The Summit T3‐16 Analyzer tracks all the Events 
and Actions defined in the Global State throughout the recording. In the Global State the 
Link State, Ordered Set, Errors, Counter and the Timer use Basic Resources while DLLP and 
TLP use Packet Match Resources. The Global State has two Timers and two Counters.

Figure 5.18: Global State

For the Global State there are only 2 Basic Resources for each Channel. Some 
optimization is done internally to accommodate additional resources. You can keep 
adding resources to the Global state so long as the Config is valid button stays green. If 
you add a new event which is not valid a window appears with a message prompting 
Invalid Recording Rules Configuration and the Config is valid button will turn red (see 
Figure 5.19 on page 65).
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Figure 5.19: Valid and Invalid Recording Rules Configuration Dialogs
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Sequence State

The cell marked Drag an event here to add another sequence is the Sequence State. In 
the Sequence State you can define a sequence of Events and Actions which the Summit 
T3‐16 Analyzer looks for at pre‐determined times. Sequences are chains of events 
culminating in a trigger or any other action. A sequence which is a separate chain of 
events can be created with up to 16 states. A state is an event condition with an action 
within a sequence. Once a Sequence State is added the cell marked will read Drag an 
event here to add another state.

Figure 5.20: Sequence State Events

In the Sequence State the Link State, Ordered Set, Errors, Counter and the Timer use 
Basic Resources while DLLP and TLP use Packet Match Resources. There are four Timers 
and four Counters in the Sequence State.

Note:Each Sequence State has four Basic Resources and four Packet Match Resources.

Events can 
be added 
to this 
Sequence 
State

Sequence 
States
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Navigating Recording Rules

The Recording Rules window has three main areas, the Toolbar, Available Events panel 
and the Main Display panel (see Figure 5.13 on page 59).

Toolbar

The toolbar contains buttons such as the New Events button for issuing commands, 
Delete Current Event, Undo, Redo, Zoom in and out, Show/Hide Channels and Properties. 

Available Events Area

The Available Events area is in the left repository panel where you can park buttons that 
you intend to use in the Main display area. The events in this panel do not affect the 
recording. You can drag and drop events in the Main Display panel.

Main Display Area

The Main Display area is the right panel where you create trigger and filter conditions. 
You create conditions by dragging buttons onto the Main display area from the Available 
Events area. You then create additional conditions by right‐clicking a button and selecting 
options from a pop‐up menu. See Creating Recording Rules.

Recording Rules Buttons

 The Recording Rules toolbar allows you to create and edit recording rules: 

TABLE 5.2:  Recording Rules Toolbar Buttons

New Event. Opens a 
drop‐down menu with a 
list of events.

Zoom in

Delete. Delete selected 
event.

Zoom out

Undo. Undoes last 
action.

Show/Hide Channels. 
Shows/hides the 
channel buttons.

Redo. Undoes last Undo 
command.

Show properties. 
Opens the Properties 
dialog for the selected 
item.
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Recording Rules Events

There are five sets of Events that can configured and actions can be set for every Event.

TABLE 5.3:  Events and Event Actions 

Event Pre-Defined Event Actions

Link State

Enter Electrical Idle

Exit Electrical Idle

Speed Change to 2.5Gb/s

Speed Change to 5.0Gb/s

Speed Change to 8.0Gb/s

Ordered Set

TS1

TS2

EIEOS

EIOS

Skip

FTS

SDS

Errors

Idle Error

Disparity Error

Symbol Error

Token Error

Block Align Error

DLLP

Generic (User‐definable)

Any DLLP

MR DLLP

InitFC1

InitFC2

UpdateFC

ACK

NAK

Power Management

Vendor
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Properties Dialog Boxes for Events

Properties dialog boxes provide additional settings for Events, States, and Actions in the 
Recording Rules page. You can access a Properties dialog by double‐clicking an Event, 
State, Action or any other object. It allows you to set triggers and filters. For example, to 
set a trigger on a specific type of error, you open the Properties dialog.

Accessing the Properties Dialog

To see the Properties dialog, first create an event button by clicking the New Events 
button and choosing an event from the menu. Open the Event Properties dialog by doing 
one of the following: 

 Double‐click an event.
 Right‐click an event and select Properties from the pop‐up menu.
 Click the Properties button on the toolbar.

Event Properties Dialog Box Features

The following features are displayed in the any Event Properties dialog box (see 
Figure 5.21 on page 70).

Event Icon Preview

This icon shows you which event properties you are editing. The Icon Preview looks 
exactly like the icon in the Main Display area.

Icon Label

A text box for labeling the button. Whatever you type here appears on the button.

TLP

Generic (User‐definable)

Any TLP

Config Rd

Config Wr

IO Rd

IO Wr

Mem Rd

Mem Wr

Message

Completion

TABLE 5.3:  Events and Event Actions 
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Channels

These controls allow you to select the channel(s) that the Analyzer should search when it 
is looking for the event. 

Pin Button

The Pin Button on the top right corner of the dialog allows you to pin the Properties 
dialog to the application so that it does not go away when another object appears such as 
an event, state or action.

Description String

This area contains a textual description of the event.

Event‐specific Settings

The largest part of the Event Properties dialog. The settings in this area vary for different 
events. Some events do not have any additional settings. 

Figure 5.21: Properties Dialog Box
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Link State Dialog

The Link Properties dialog lets you select the link state. 

 

Figure 5.22: Link State Properties Dialog

Ordered Set Properties Dialog

An Ordered Set cannot be filtered in a Global State, but can be filtered in a Sequence 
State. 

Figure 5.23: Ordered Set Properties Dialog
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Error Properties Dialog 

The Error Properties dialog lets you select specific error types for performing an action. 
There are two sets of Error types: Packet Errors and Idle Errors.

 

Figure 5.24: Error Properties Dialog

DLLP Packet Properties Dialog

The DLLP Packet Properties dialog allows you to specify any DLLP field as shown below. 

Figure 5.25: DLLP Packet Properties Dialog
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The Layout tab of the DLLP Packet Properties dialog allows you to change the pattern and 
customize it by defining each specific bit as shown in the figure below.

Figure 5.26: DLLP Packet Properties Dialog

TLP Header Properties Dialog

The TLP Header Properties dialog enables you to set the TLP Header Fields and Layout, 
TLP Prefixes and Actions. You can manually change the Requester/Completer ID.

Figure 5.27: TLP Header Properties Dialog



LeCroy Corporation Properties Dialog Boxes for Events

74 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual

TLP Prefix Properties Dialog

The Layout tab of the TLP Prefix Packet Properties dialog allows you to change the pattern 
and customize it by defining each specific bit as shown in the figure below.

Figure 5.28: TLP Prefix Properties Dialog 

Actions Properties Dialog

Every Event has an Action tab as shown in Figure 5.29 on page 75. 

The following tables describes the Actions for each Event.

TABLE 5.4:  Event Actions 

Action Description

Label  Label the action.

Channels Select Channels to go upstream or downstream.

Internal Triggering Check the box to enable Internal Triggering.

External Triggering Set the External Triggering to Low, High or Toggle. The 
default is None.

Sequence Set the Sequence to Advance. The default is None.

Filtering Set the Filtering to Filter Out. You cannot Filter In in the 
Summit Z3‐16. The default is None.

Local Timer Set the Local Timer, there are four options available.

Action You can set the Action of the timer to Start or Reset. 
When you reset the timer it resets to it’s initial value. The 
default is No Action.

Local Counter Set the Local Counter, there are four options available.

Local Counter Action You can set the Action of the Counter to Increment or 
Reset. The Counter increments by one and resets to its 
initial value. The default is No Action.
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Figure 5.29: Actions Properties Dialog

Global Timer Set the Global Timer, there are two options available.

Global Timer Action You can set the Action of the timer to Start or Reset. 
When you reset the timer it resets to it’s initial value. The 
default is No Action.

Global Counter Set the Global Counter, there are two options available.

Global Counter Action You can set the Action of the Counter to Increment or 
Reset. The Counter increments by one and resets to its 
initial value. The default is No Action.

TABLE 5.4:  Event Actions 
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Counter

Counters can be created for any specific event or for multiple events. Counters function 
similar to an event and are independent of the event, thus allowing greater flexibility. You 
can select a counter for any event and if both channels are selected you can set the 
counter to count upstream and downstream. Counters can be reset providing further 
flexibility. The counter once set lives in the State. In an Advance to Sequence state once 
the action proceeds from one sequence state to the next, the counter in the preceding 
state will stop and the counter in the current state will start.

There are two Counters for the Global State and four Counters for the Sequence State.

Note: It is an invalid configuration for some events when you try and set a counter and timer 
when both channels are selected.

The counters have different colors for the Global State and Sequence State. Each color 
signifies a different meaning in the Global and Sequence states.

Figure 5.30: Global and Sequence State Counters

As shown in Figure 5.30 there is a Global Counter 1, set to the value of 2 on channel up 
displayed in green in the Global State and there are two counter 1s, set to the value of 2, 
one counting upstream and the other counting downstream displayed in pink in the 
Sequence State.
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How to Set a Counter

Counters are events and you can add a counter to the Global State or the Sequence State 
as an event by doing the following:

Right‐click in the blue space in the Global or Sequence State and New Event > Counter > 
UpStream or DownStream. See Figure 5.31 on page 77.

Figure 5.31: Setting Global and Sequence State Counter Events
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How to Increment or Reset a Counter

You can Increment or Reset counters in the Global State and in the Sequence State by 
performing the following steps:

1. Open the Recording Rules page, select an event, and drag it to the Global State or 
Sequence cells. For details on these steps (see “Defining Recording Rules” on page 
84).

2. Right‐click on an event and select Specify Actions > Increment Global Counter > 
Global Counter 1 from the menu. See the figure below.

Figure 5.32: Incrementing and Resetting Global and Sequence State Counters

Changing the Value of the Counter

To change the value of the counter:

1. Double‐click on the Counter.

2. Enter a new value in the pop‐up dialog. This causes the new value to appear in the 
counter button.

Deleting a Counter

To delete a counter

1. Right‐click on the Counter. 

2. Select Delete This Event. The counter will disappear from the event.
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Timer

The Timer has two options which are Start and Reset. When set to Start it starts the timer 
and when set to Reset it resets the timer to its initial value. When the timer count is down 
to 0 the action is triggered.

The Global State timer can trigger, start an action. It can also affect some other timers and 
counters.

Note: It is an invalid configuration for some events when you try and set a counter and timer when 
both channels are selected.

The timers have different colors for the Global State and Sequence State. Each color 
signifies a different meaning in the Global and Sequence states.

There are two Timers for the Global State and four Timers for the Sequence State.

Figure 5.33: Global and Sequence State Timers

As shown in Figure 5.33 there is a Global Timer A, set to the value of 0.000000 ns on 
channel Up displayed in blue in the Global State and there is one timer A, set to the value 
of 0.000000 ns on channel Down displayed in brown in the Sequence State.
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How to Set a Timer

Timers are events and you can add a timer to the Global State or the Sequence State as 
an event by doing the following:

Right‐click in the blue space in the Global or Sequence State and New Event > Timer > 
UpStream or DownStream. See Figure 5.34 on page 80.

Figure 5.34: Setting Global and Sequence State Timer Events



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 81

Timer  LeCroy Corporation

How to Start or Reset a Timer

You can Start or Reset the Timer in the Global State and in the Sequence State by 
performing the following steps:

1. Open the Recording Rules page, select an event, and drag it to the Global State or 
Sequence cells. For details on these steps (see “Defining Recording Rules” on page 
84).

2. Right‐click on an event and select Specify Actions > Start Global Timer > Global 
Timer A or Timer B from the menu. See the figure below.

Figure 5.35: Starting and Resetting Global and Sequence State Timers
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Changing the Value of the Timer

To change the value of the timer:

1. Right‐click on the Timer. 

2. Select Properties 

3. Enter in values for the Timer in the fields provides in Secs, Millisecs, Microsecs and 
Nanosecs on the Timer tab.

Figure 5.36: Setting the Timer Values

4. Click on the Actions tab and set the External and Internal Triggering, Sequencing and 
Filtering options. You can label the timer.

Deleting a Timer

To delete a Timer

1. Right‐click on the Timer. 

2. Select Delete This Event. The Timer will disappear from the event.



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 83

Channel  LeCroy Corporation

Channel

Every event has two channels, one upstream and the other downstream. You can use 
both channels with any event. The channels are independent of each other. If both 
channels are selected it is valid but no action occurs, and thus no timer and counter is 
created. Figure 5.37 shows three events in the Global State, the first event is on Channel 
Up and the 3rd event is on Channel Down.

Figure 5.37: Events with Channels
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Defining Recording Rules

The Recording Rules page is used to set triggers and filters. To access this page, select 
Setup > Recording Options > Recording Rules.

You can also access the New Event menu by right‐clicking in the blue space in the Global 
State or in the Sequence State (see Figure 5.38 on page 84).

Figure 5.38: Defining New Events

There are three steps to creating a recording rule: 

1. Select events.

2. Place the events in the Global State or Sequence cells.

3. Assign actions to the events.

Note:There are limits to the types of rules that can be created. 
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1. Click and select one or more events from the menu. Selecting an 
event automatically places it in the Available Events area. This repository area serves 
as a parking lot where you can place event buttons without them having any effect 
on the Analyzer. 

2. Drag the selected events from the Available Events area into either the Global State 
Cell or the Sequence Cell (see “Recording Rules Overview” on page 60). 

Global State Cell

If you want the Analyzer to always search for the event, place it in the cell marked 
Global State.

Sequence Cell

To create an event sequence, place two or more events in the faintly marked cell 
that reads Drag an event here to add a new sequence. At this point, the selected 
events have no effect because an action has not been assigned.

3. To select a sub‐set of your selected event, right‐click it and choose Properties. A 
Properties dialog opens that presents additional options. For example, if you open 
the Properties dialog for Errors, you can set the specific types of errors the Analyzer 
should look for. 
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4. Assign an action to the selected events by right‐clicking each of the events, selecting 
Specify Action from the pop‐up menu, and assigning an action such as Trigger, 
Filter, or Count. Be sure to click the event itself and not the State cell that it is sitting 
in (which produces a different pop‐up menu).

Figure 5.39: Assigning an Action

Note:You can also assign actions to events by double‐clicking the event or action and selecting the 
Actions page when the Properties dialog opens (see “Event Properties Dialog Box Features” on 
page 69).

5. Click OK to close the dialog. At this point, assuming that the other options in the 
Recording Options dialog have been set (such as the General page), you can begin 
the recording by pressing the 

Start Recording button.
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Filter Out

A filter causes the Analyzer to filter out specified events from the recording. If events are 
filtered out of the recording, they are excluded from the Analyzer's buffer and not simply 
hidden from the CATC Trace. The purpose of filtering is to preserve recording memory so 
you conduct longer recording sessions and exclude events that do not interest you.

A filter causes the Analyzer to filter out specified events from the recording so you can 
preserve recording memory and thereby increase the duration of your recording. Filtering 
also lets you exclude unwanted data so your CATC Trace displays only the traffic that 
interests you.

To enable or disable filtering, place an event button into either the Global State cell or 
the Sequence cell, then right‐click the button and choose an Action (see previous topic). 

From the sub‐menu, select Filter Out.

Figure 5.40: Filter Out Option 

Note:The Filter Out option is only available in the DLLP, TLP, and Ordered Sets TS1 and TS2.



LeCroy Corporation Filter Out

88 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 89

Chapter 6

Reading CATC Traces

Viewing PCI Express CATC Traces

PETracer™ displays traffic as labeled, color‐coded, and time‐stamped rows. 

Tool tips provide details about fields within the CATC Trace. Hold the mouse cursor over a 
field to see a tool tip. 

Additional information is available from pop‐up menus. For example, if you click the left 
mouse button on the first cell in a packet a menu appears with an option to view 
Raw 10b Codes.

Expand and Collapse Data Fields

Packet data fields are displayed in a short format by default. 

You can view a data field’s long format by performing one of the following three actions:

 Click the small triangle in the left corner.
 Double‐click anywhere in the data field.
 Click once in the Data Field with the left mouse button, then choose Expand Data 

from the pop‐up menu. 

A repeat of any above methods causes the display to return to a Short Data format.
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Resizing Cells

Data cells can be resized by pointing the mouse pointer on the edge of a data cell, 
depressing and holding the left mouse button, and then repositioning the mouse pointer 
while keeping the mouse button depressed.

Pop-up Menus

The Analyzer software makes extensive use of pop‐up menus. In some instances, pop‐up 
menus provide the only means of accessing dialogs that contain detailed information 
about cells within the CATC Trace, for example, the Show Configuration Space dialog. 

To see a pop‐up menu, left‐click or right‐click a cell within the CATC Trace. Right‐click or 
left‐click behavior depends on the Display Options setting. For default left‐click, the right‐
click menu is not cell‐dependent. For other left‐click behavior, the type of menu that 
opens varies depending on the type of cell that is selected. Take some time to explore 
CATC Traces and the various pop‐up menus.

View Data Block

To view the raw bits that make up the data in a data field, left‐click a data field, then click

 or select View Data Block from the pop‐up menu to display the Data Block window

Figure 6.1: Viewing a Data Block

You can display data in Hexadecimal, ASCII, Decimal, or Binary formats.

Bit Order is Most Significant Bit or Least Significant Bit.
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You can display data in Big Endian or Little Endian.

Format lets you display data as BYTEs, WORDs, or DWORDs.

Columns lets you select the number of columns.

You can enter hexadecimal offset values.

You can go to or search Previous or Next.

Show Raw 10b Codes

You can view the raw bits that make up the data field by left‐clicking the field and 
selecting View Data Block from the pop‐up menu.

To view Raw 10b Codes:

1. Left‐click the first cell in a packet.

2. Select Show Raw 10b Codes from the pop‐up menu to display the Raw 10b Codes 
window 

3. To change the format of the data, use the options along the right side of the dialog. 

4. To navigate the CATC Trace, use the Prev and Next buttons.
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Show Header Fields

You can view details about header fields by opening the Show Header Fields dialog.

1. Click a header. A pop‐up menu appears.

2. Select Show Header Fields. The following dialog opens.

3. Use the Prev and Next buttons to navigate to other headers.
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Packet Cell Popup Menus

The Packet cell has a left‐click pop‐up menu that includes the Show Raw 10b Codes 
command: 

The right‐click pop‐up menu from Packet cell is displayed below: 

Packet Header R-> Cell Popup Menu

The Packet Header R‐> cell has a pop‐up menu with the Swap Upstream/Downstream 
command, which changes the directionality of the packets in the CATC Trace.
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Packet Header G1 Cell Popup Menu

The Packet Header G1 cell has a pop‐up menu with the Show Header Fields command 
(see “Show Header Fields” on page 92), which exposes a detailed view of the selected 
Header field.

Set Marker

A marker is a unique label for a packet that allows you to go to that packet and also serves 
as a comment string for a specific packet. When you select a marker, the identified 
packet appears at the top of the screen. Packets that have been marked have a red bar on 
the left edge.

To set a marker, perform the following steps:

1. Left‐click the Packet field of the packet you want to mark.

2. Click Set Marker.
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3. When the Edit Marker for Packet # pop‐up appears, enter a unique identifier for the 
packet in the Comment field. 

Later, you can go directly to this packet using the Go To Marker operation in the Search 
Menu. 

Edit or Clear Marker

To change a markers identifier, or clear (delete) the marker:

1. Left‐click the Packet field of the desired packet to display a pop‐up menu: 

2. Choose Edit Marker and enter a new identifier into the Edit Marker for Packer # 
pop‐up, or 
Choose Clear Marker. When you choose Clear Marker, the marker is removed and 
the red line disappears.
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Decoding Traffic

The PETracer software has three decode levels: 

Packet

Packet level decode includes all TLP packets, DLLP packets, and all ordered sets.

Link

Link level decode is composed of TLP packets matched with a corresponding ACK or 
NAK coming from the opposite direction.

Split

Split level decode is composed of two Link transactions, the Request TLP and the 
Completion TLP from the other direction.
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Searching CATC Traces

This chapter describes how to search for CATC Trace events.

CATC Trace Search Overview

Several search commands let you navigate a CATC Trace view to search for key events, 
such as errors and triggers. 

To view the search options, click Search in the Menu bar. 

Go to Trigger

To position a trigger packet at the top of the screen:

Select Search > Go to Trigger.

Go to Packet

To position a packet at the top of the screen:

1. Select Go to Packet from the Search menu. A pop‐up menu prompts you for the 
packet number, marker, or time.

2. Enter the packet number, marker, or time.

3. Click OK.
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Go to Time

To position a specific time at the top of the screen:

1. Select Go to Time from the Search menu. A pop‐up menu prompts you for the time 
in Seconds or Clocks.

2. Enter the time and format (seconds or clocks).

3. Click Go.

Go To Marker

Use this operation to go directly to a specific packet that has been marked with a unique 
marker by the Set Marker operation. 

To go to a marker: 

1. Select Go To Marker from the Search Menu.

2. Select the marker you want from the fly‐out menu.
Alternatively, select All Markers to display the All Markers window, then select a 
marker and click Goto.

The packet you want appears at the top of the screen. Marked packets have a red bar on 
the left edge.
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Go To Menu

The Go To menu in the Search menu provides a quick way to search for a packet based on 
a simple condition. You can search for the following types of events:

 TLP Type
 DLLP Type
 Ordered Set
 Link Event
 Traffic Class
 DLLP Virtual Channel
 TLP Virtual Channel
 Direction
 Speed
 Link Width
 Requester ID
 Completer ID
 Data Lengths
 Errors

Search Direction

Search direction can be toggled back and forth by using the command under the Search 
menu. Search Direction controls the direction of the search. Each time Search Direction is 
selected, the search order is reversed. For example, if the previous search was forward, 
choosing Search Direction toggles the current search to backward.

To verify the direction of a search look at the lower right corner of the screen. 
Search: Bwd or Search: Fwd should appear. If a direction is not indicated, it means that 
the status bar is turned off. 

To turn on the Status bar, select from the menu View > Status Bar. 

Keyboard shortcuts can also be used to control search direction: 

 Control‐f means Search Forward.
 Control‐b means Search Backward.
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Find

Find allows you to conduct complex searches in a CATC Trace. You can search by protocol 
level (Packets, Link Transactions, Split Transactions).

You can search packets by Event Group: TLP Type, TLP Header, TLP Prefix, 
TLP Requester ID, TLP Completer ID, TLP Data Pattern, TLP Data Lengths, TLP Tag, 
TLP Sequence Number, DLLP Type, DLLP Header, DLLP Virtual Channel, ACK/
NAK Seq Number, Ordered Sets, Link Event, Direction, Errors. 

You can search link transactions by Event Group: TLP Type, Traffic Class, Virtual Channel, 
Direction, Requester ID, Completer ID, Status, Tag. 

You can search split transactions by Event Group: TLP Type, Traffic Class, Virtual Channel, 
Direction, Requester ID, Completer ID, Status, Tag. 

The options Union, Intersection, and Exclusion allow you to create complex searches such 
as “Find x OR y” or “Exclude all x or y.” 

To find an item:

1. Open a CATC Trace.

2. Open Find by selecting Search > Find from the menu or clicking .

3. From the Search For menu, select a display level such as Packets. To search multiple 
levels, finish steps 3 to 9, and then repeat 3 to 9 for each additional display level.

4. From the Event Groups menu, select an Event Group. The menu in the far right of 
the dialog is context sensitive and changes to reflect the options for that group.

5. In the menu in the far right, select one or more items.

6. Repeat Step 5 for each Event Group of interest for the selected display level.

7. Under Direction, select Forward or Backward to select a search direction.

8. Under Origin, select a starting point for the search.
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9. Under Combining Specified Event Groups, select an option.

The options Union, Intersection, and Exclusion let you set conditions on your searches:

 Union: To search for any of the selected criteria. 
Example: “Find packets with ANY of the following characteristics …”

 Intersection: To search for all of the selected criteria. 
Example: “Find packets with ALL of the following characteristics …”

 Exclude: To exclude items from a search. This option works in conjunction with 
Union and Intersection. You select Union and Exclude to exclude any of the spec‐
ified traffic. You select Intersection and Exclude to exclude all of the specified 
traffic. 
Example: “Exclude packets with ANY of the following …” or 
“Exclude packets with ALL of the following …” 

1. Repeat Steps 3 through 9 for additional display levels.

2. Find All displays all matching packets or transactions in a separate view.

3. Search in Hidden includes hidden packets or transactions in the search.

4. Click OK.
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Event Groups

The Event Groups for Packets are:

 TLP Type
 TLP Header
 TLP Prefix
 TLP Requester ID
 TLP Completer ID
 TLP Data Pattern
 TLP Data Lengths
 TLP Traffic Class
 TLP Tag
 TLP Sequence Number
 DLLP Type
 DLLP Header
 DLLP Virtual Channel
 ACK/NAK Seq Number
 Ordered Sets
 Link Event
 Direction
 Errors

The Event Groups for Link Transactions and Split Transactions are:

 TLP Type
 Traffic Class
 Virtual Channel
 Direction
 RequesterID
 CompleterID
 Status
 Tag

Search for the Next Packet Type

Use Find Next or click   to search for the next packet meeting the search criteria. 
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Chapter 8

Display Options

Setting Display Options

Display Options allow you to customize the colors and formats of displayed traffic. 

To open the Display Options dialog at the General tab, Select Setup > Display Options 
from the menu or

click the Display Options button on the toolbar.

Figure 8.1: Display Options Dialog - General Tab
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Specifying General Display Options

The Display Options General tab allows you to specify:

Zoom Level: Defines the size of packet fields in the packet view. Zoom level is adjustable 
as 10, 20, 40, 60, 80, 100, 120, 140, 160, 180 and 200 percent.

Enable Tool tips: Allows information to be displayed on a packet by resting your mouse 
pointer over it.

Wrap: Allows packets, Link Transactions, and Split Transactions to wrap within the 
display.

Hierarchy Lines: Adds lines to the trace view indicating relations between packets, 
Link Transactions, and Split Transactions.

Timestamp position: Moves timestamp location from end of packet to beginning of 
packet, or merges it with the packet number.

Trace Viewing Level: Allows the CATC Trace to be displayed in different hierarchical 
levels: Packets, Link Transactions, Split Transactions and NVM Transactions.

Time Stamp: Gives you options for setting the timestamp to zero for either the first 
CATC Trace packet or the trigger packet or for leaving the stamp unchanged as it was 
originally recorded.

Fonts

Fonts: Allows the appearance of field text and/or data text to be defined.

Configuration Name

Display Configuration Name: This field is used to enter a text string to be associated with 
the current set of Display Options. This name is saved with the Display Options file, and 
appears as part of the title of the packet view window that uses this set of Display 
Options.

Color, Format, and Hiding Options

The Color/Format/Hiding tab allows you to customize the colors and formats associated 
with each field in the CATC Trace and to selectively hide fields or packets. You access 
these display options by selecting Setup > Display Options > Color/Format/Hiding tab. 

The Color/Format/Hiding property page lets you set how fields display in a CATC Trace. 
This property page lets you set field color and data format (binary, hex, decimal, ASCII), 
and lets you hide selected fields from the display. See the following screen capture.



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 105

Specifying General Display Options  LeCroy Corporation

Figure 8.2: Display Options Dialog - Color/Format/Hiding Tab

Setting Field Colors

The Field Colors tab allows you to customize the colors associated with each field used in 
the packet view. 

You may experiment with this option to achieve a color combination that suits you. 

Select or change the trigger color using the color buttons labeled ‐ Packet # and 
+ Packet # (before and after trigger) found under the Packet# section of the Field Colors 
window. 

You select or change a color by clicking the appropriate color button. This action causes a 
color palette to pop up. Select the desired color and press OK.

1. Click View > Set Display Options to open the Display Options dialog.

2. Select the Color/Format/Hiding property page.
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3. Under the Group and Colors column, click the plus symbol (+) next to the group you 
want to reformat. The group expands to show the individual fields within the group. 
Each field has a color, as shown below:

4. Click the colored cell that you want to change. A color palette appears.

5. Click a color in the palette, then click Apply or OK. 

Note:The colors of the following Frame types cannot be changed: 

 Invalid Data (frame error) field (red)
 Softbit Errors (yellow)

You can also change color by left‐clicking a field in the CATC Trace and selecting Color 
from the pop‐up menu

.

Figure 8.3: Display Options Dialog Color/Format/Hiding Tab



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 107

Specifying General Display Options  LeCroy Corporation

Changing Field Formats

The Field Formats tab allows you to define the way various numeric fields are shown in 
the packet display. You can select Hexadecimal, Decimal, Binary, or ASCII for certain fields 
or groups of fields. 

To change a field's format, click the plus sign (+) next to a field in the list. This causes the 
selected item to expand so you can see its constituent sub‐fields. Select a sub‐field, and 
then choose the format from the formatting choices that appear at the bottom of the 
window.

Figure 8.4: Display Options Dialog Color/Format/Hiding Tab

To change the format of alphanumeric characters in a field: 

1. Under the Group and Colors column, click the plus symbol (+) next to the group you 
want to reformat. The group expands to show the individual fields within the group 
(as shown above).

2. Click the row representing the field that you want to reformat. If the field can be 
reformatted, the format options at the top of the dialog become active, as shown 
below:
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3. Select a format.

4. Specify the bit order in the displayed fields by checking/unchecking the MSB > LSB 
checkboxes.

5. Click Apply or OK. 

Hiding Fields

To hide a field:

1. Under the Group and Colors column, click the plus symbol (+) next to the group that 
has the field(s) you want to hide. The group expands to show the individual fields 
within the group (as shown above).

2. Click the checkbox in the row representing the field that you want to hide.

3. Click Apply or OK.

Hiding Levels

The Level Hiding page lets you hide traffic by Event Group. If you select one or more 
event types from the Event Group list, the selected types are hidden from the CATC Trace.

Figure 8.5: Display Options Dialog - Level Hiding Tab
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Load a Previously Saved Display Options File  LeCroy Corporation

To hide a level:

1. Select an Event Group.

2. Select whether to Hide or Show selected items.

3. Select Upstream, Downstream, or Any Direction.

4. (Optional) Select Compact EIEOS packets.

5. Click OK.

The Event Groups for Packets are:

 TLP Type
 TLP Header
 TLP Requester ID
 TLP Completer ID
 TLP Data Pattern
 TLP Data Lengths
 TLP Traffic Class
 TLP Tag
 TLP Sequence Number
 DLLP Type
 DLLP Header
 DLLP Virtual Channel
 ACK/NAK Seq Number
 Ordered Sets
 Link Event
 Direction
 Errors

The Event Groups for Link Transactions and Split Transactions are:

 TLP Type
 Traffic Class
 Virtual Channel
 Direction
 RequesterID
 CompleterID
 Status
 Tag

Load a Previously Saved Display Options File

If you have previously saved Display Options, you can load them by opening the Display 
Options dialog and clicking the Load button. A dialog opens to let you load a previously 
saved display options file.

1. Click Load to use a previously defined display options file.

2. When you see the Open File pop‐up window, enter the name of the file you want to 
load and click Open. 

3. When the PETracer™ software returns you to the Recording Options menu, click OK 
to activate the display options you selected.
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Saving Display Options

If you have customized the Display Options and wish to save them, you can do so by 
clicking the Save button, then entering a unique file name. The .opt extension is added by 
default.

Setting the Defaults: Save the currently specified Display Options to the file name: 
default.opt by clicking Save As Default. When the Analyzer software begins execution, it 
automatically loads the default.opt file, if one exists.
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Chapter 9

BitTracer Recording

Note:BitTracer Recording is an optional feature.

The Summit T28 analyzer has an optional BitTracer data capture mode, which captures bi‐
directional link traffic in raw format. The BitTracer recording mode captures and displays 
traffic before lane‐to‐lane de‐skew operations and before descrambling of 10b bytes. The 
BitTracer mode includes support for multiple logical links (bifurcations) on a single 
physical link.

The BitTracer recording mode has its own user interface, which provides characterizations 
of link traffic that are not available in the standard protocol analyzer mode.

You can export BitTracer recordings for viewing in CATC Trace format.

Note:BitTracer Mode recording is only available in the LeCroy Summit T28 PCI Express Gen2 Protocol 
Analyzer and is an optional feature. This feature can be included at initial purchase or added in 
the field with a software upgrade license. To obtain a software license key to add this feature, 
contact LeCroy.

Enabling BitTracer Recording

To enable the BitTracer recording mode, open the Recording Options. 

In the Target Analyzer section of the General tab, select Summit T28.

In the Recording Type section, select Bit Tracer Recording.
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.

In Bit Tracer Recording, you can use the Snapshot, Manual Trigger, and Event Trigger 
recording types.

Note:You can also use other standard Recording Options, such as Link Width, Buffer Size, and Lane 
Polarity Settings, to characterize the link.

Views Available for Captured Data

BitTracer mode displays captured data lane‐by‐lane and byte‐by‐byte in each direction 
(upstream and downstream), with the time scale progressing left to right

Other views are provided for timing measurements, marker placement, physical layer 
errors, captured symbol types, packets, events, and decoding of ordered sets and 
packets. You can view any or all displays simultaneously, using the Windows selection in 
the View menu. 
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De‐skewing Data  LeCroy Corporation

De-skewing Data

By default, BitTracer recordings display captured data in a raw, time‐skewed format, 
across all lanes in both directions. Individual bytes are as they were captured on the 
recorded link, before the receiver device on the link (or the receiver logic on the PETracer 
analyzer) has performed lane‐to‐lane de‐skew operations.

You can manually skew the captured data, left or right, in increments of one symbol time, 
using the associated toolbar buttons.

You can automatically de‐skew an entire lane direction. First, left‐click on the direction in 
the data window. Then right‐click to display a popup menu. Then select Auto De‐Skew.

You can de‐skew only one direction for each right‐click operation. To automatically de‐
skew the opposite direction, first left‐click on that direction in the data window.

Data Display Formats

To display traffic in K/D symbol (with Running Disparity indicated), scrambled, 
descrambled, 10‐bit, and Binary code formats:

 Use the toolbar.

 Right‐click to display a menu.
 Place the cursor over any given byte to display all byte formats (including an LFSR 

value) in pop‐up list. 

Note:Descrambled values can only be displayed after the first recorded skip ordered set. Data prior to 
the skip is displayed in scrambled values, due to the unknown LFSR.

Note:For Binary Data Display Format, bits are shown in order of transmission on the bus.
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Color-Coding of BitTracer Contents

To increase visual understanding of BitTracer displays, different symbol types have color‐
coding:

 Presence or non‐presence of a lane’s byte‐lock
 Idle data characters (D0.0)
 K codes
 Invalid 10b symbols
 Signal presence
 Background of the Markers Bar (see “Markers Bar” on page 115) 

(color coded according to traffic speed).
 All symbols of a TS1/TS2 ordered set

By default, these color selections match the standard color selections used in the 
CATC Trace format. You can modify them in the Display Options menu, accessible from 
the Main toolbar or the Setup menu.

Report and Analysis Windows

In the report windows, BitTracer mode provides several functions to analyze traffic:

 Statistical information
 Timing measurements
 Packet decoding

To activate/deactivate a report window, use Views > Windows

You can rearrange the report windows.

All report windows are dockable. 
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Timing Measurements Bar  LeCroy Corporation

Timing Measurements Bar

BitTracer mode provides timing measurements on captured data:

 Measurements from the Trigger position relative to user‐selected X and Y mark‐
ers

 X‐Y measurements
 Measurements between user‐defined markers

Markers Bar

The Trigger marker   is at the point where BitTracer recognized the user‐defined 
trigger condition. 

To set an X marker  , left‐click anywhere in the data display, except for the light gray 
bar located above the data and below the directional label. 

To set a Y marker  .right‐click anywhere in the data display, except for the light gray 
bar located above the data and below the directional label. 

To define a marker, select the Set Marker command in the Markers menu or use the 
Toggle Marker icons in the toolbar. You can also use the Jump to Next or Previous marker 
icons in the toolbar.

User‐defined markers are numbered in the order they were placed:

 U1  , U2, and so on in the upstream direction

 D1, D2  , and so on in downstream direction.

You can set a marker with text using the Set Marker with Text… command in the Markers 
menu. After setting the marker, when the mouse pointer is on the marker symbol, the 
marker text displays as a tooltip.



LeCroy Corporation Timing Measurements Bar

116 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual

You can also display the Markers window, which lists all markers and their locations, 
including a hyperlink for each.

Figure 9.1: Markers Window

Timing measurements between all combinations of X, Y, U, and Trigger cursors are in the 
Timing window.

Figure 9.2: Timing Window
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Errors Bar  LeCroy Corporation

Errors Bar

BitTracer mode provides a summary of 10b errors (invalid symbols) and disparity errors in 
the Errors window. The window shows the total error count and errors per‐lane for each 
error type. Hyperlinks allow jumps to selected errors.

Figure 9.3: Errors Window

BitTracer mode also highlights errors:

 Invalid symbols have a black background.
 Bytes with incorrect running disparity have red borders.

Symbols Bar

The Symbols window provides a summary of the different symbol types captured, by 
quantity and direction, and includes hyperlinks for jumps to selected symbols.
Expanding the + sign at the left of each symbol provides a summary of symbols by lane.

Figure 9.4: Symbols Window
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Events Bar

The Events report window summarizes Link Up, Link Down, and Speed Switch events for 
Upstream and Downstream.

Figure 9.5: Events Window

Note:The table entries are hyperlinks.

Packets Bar

The Packets report window summarizes packet types detected in the file.

Note:To obtain packet types, you must perform a post‐capture “Analyze” step. After capture, when 
you open the Packets Bar for the first time, items can display the command “Analyze”. To start 
the analysis, click the word Analyze. After analysis finishes, the results are saved with the file. 
Therefore, you do not need to click Analyze the next time.
The table entries are hyperlinks.

Note: If you edit anything, the results are no longer valid, and the system requires you to click Analyze 
again.
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Packets Bar  LeCroy Corporation

Figure 9.6: Packets Window

After analysis, the Packets Bar looks like the following:
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Decoding Bar

If you select them in the data view, or search or jump locates a feature, BitTracer mode 
displays ordered sets and packets in the Decoding window:

 Logical view is identical to CATC Trace format.
 Specification view provides a more elementary display. The Specification view 

includes an option to display data in hex or binary format.

Note:Packets and ordered sets translate directly to this view from data capture and use any post‐
capture skew manipulations you add, or use natural lane‐to‐lane skew present on the link if you 
have not added post‐capture skew manipulations. Typically, you would perform an Auto De‐
Skew before viewing ordered sets and packets in this view.

Use the left and right arrows to search for the next or previous symbol type.

Figure 9.7: Decoding Window



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 121

Search  LeCroy Corporation

Search

To search, use the Search toolbar.

Clicking the Search icon displays the Search window.

Figure 9.8: Search Window

You can copy data shown in the BitTracer display across a lane (horizontally) or across 
multiple lanes (vertically), and then paste it into the Search Pattern window. 

The Search Pattern window stores previous search values, which you can recall by 
selecting the Search Pattern drop‐down button.

In the Pattern Format section, select to search in 10‐bit Codes, Scrambled Bytes, or 
Descrambled Bytes format.

In the Search Order section, select to search Across Lanes (multiple lanes, vertically) or 
Along Lanes (individual lanes, horizontally).

To define the direction (upstream or downstream) and the lanes on which to search, use 
the Search On section.
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Link Configuration

Use the toolbar icon or right‐click in the data views to display the Link Configuration 
dialog. This dialog allows you to associate logical lanes with physical lanes, thereby 
providing support for lane bifurcation (multiple logical links on the same physical link).

After logical lanes map to physical lanes, BitTracer mode reconfigures the display to show 
the selected logical link (and the logical link width, as the link width selected in the 
dialog). 

Use the arrows to force symbol time skew on any lane.

Use the polarity checkbox to invert lane polarity on the selected lane or use the +/‐ 
toolbar icon.

Use the scrambling option to select a scrambling algorithm, as per specification 1.0a or 
legacy specification 1.0. 

Note:This dialog applies to one direction at a time (upstream or downstream). Left‐click in the 
direction in the data display to edit the configuration for that direction.
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Link Configuration  LeCroy Corporation

Figure 9.9: Link Configuration Dialog

As you perform operations that affect display configurations, the application records 
them. To undo or redo operations, use the Undo and Re‐do icons on the toolbar.
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Export of BitTracer Capture to CATC Trace Format

You can export BitTracer captures to standard CATC Trace file formats, selecting the 
Export option from the File menu. 

Note:You should use the Auto De‐skew feature before using the export feature. 

The exported CATC Trace keeps association information with the original BitTracer file. 
Such traces scroll synchronously when you select the Synchronize Traces option in the 
Windows menu. 

You can navigate between BitTrace and CATC Trace using the Show in Trace View/
Show Packet in Raw Trace context menu.

Exports Involving Multiple Logical Links on One Physical Link

If a single BitTrace capture contains more than one logical link, you can export each 
logical link to CATC Trace format. You may then cascade or tile the various BitTracer 
exports, which then scroll together in linked fashion, along with the original BitTracer file. 
The Export dialog provides options to export a limited range within the BitTrace capture 
and to automatically open the exported capture in CATC Trace format. 

Compressing and Expanding the Data View

You can compress (zoom out) the horizontal timing of the displayed data to view higher‐
order link behaviors. You can expand (zoom in) to examine higher‐resolution views. 

To zoom in or zoom out, right‐click the data view, then select a command or select a zoom 
icon on the toolbar.

Alternatively, to zoom in, left‐click and drag across a desired range of data.

Opening and Saving BitTracer Captures

You can save BitTracer captures in various file types.

You can collate and archive these files for transport, using the 
Export to Compressed Archive feature in the File menu. 

The main BitTracer files have a *.peraw extension. 

You can open these files in the PETracer application using the File > Open command.
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Chapter 10

Reports and Tools

Reports assist you in analyzing traffic recorded by the Analyzer. The available reports are: 

 File Information: To view general information about the CATC Trace file.
 Error Summary: To view a count of errors in a CATC Trace file.
 Traffic Summary: To view a summary of protocol‐related information in the 

CATC Trace file summary information about a selected group of items in the 
CATC Trace file (such as a count of particular frame or packet types).

 Bus Utilization: To display information on bandwidth usage for the transmit and 
receive channels.

 Link Tracker: Displays a detailed chronological view of events.
 Data Flow: Shows marker, packet, direction, type, length, address, payload, hand‐

shake, and timestamp information.
 Trace Navigator: Navigates within the CATC Trace to view the location of errors 

and triggers, narrow the range of traffic on display, and jump to any point in the 
CATC Trace.

 LTSSM Flow Graph: Shows a state diagram of bus activity.
 Packet Header: Shows packet header information
 Packet Data: Shows packet information.
 Configuration Space: Displays a Configuration Space.
 Metrics: Measures key operating parameters.
 TC to VC Mapping: To display how Traffic Classes are mapped to Virtual Channels 

(to simplify navigation) and how the CATC Trace display was changed (for exam‐
ple, in Split Transactions).

 Timing Calculations: To view timing measured between two events set within 
the CATC Trace file.

 NVM Base Address Mapping: Presents the dialog for the NVMHCI Base Address. 
This dialog displays the Device ID and whether or not the device is NVM.

 Run Verification Scripts: Allows you to check errors, link transactions, split trans‐
actions, metrics, ordered sets, replays, DLLPs, and TLPs.

Reports are available from the Report menu and buttons on the Tool bar. Tools are 
available from the Tools menu. 
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File Information

The File Information window provides a summary on the currently displayed file.

Select Reports > File Information to obtain the File Information window.

Figure 10.1: File Information Window
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Error Summary  LeCroy Corporation

Error Summary

The Error Summary dialog displays the number of errors for each event and the packet 
containing the errors.

Select Reports > Error Summary to open the Error Summary dialog.

Figure 10.2: Traffic Summary Dialog
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Traffic Summary

The Traffic Summary window summarizes the traffic in the current CATC Trace. The left 
side of the window displays a tree of protocol levels. The right side displays a summary of 
traffic for the displayed levels. 

Select Reports > Traffic Summary or click to display the Traffic Summary window

Buttons at the top of the Traffic Summary window change the display format and enable 
data to be exported to email, file, or the printer.

Using the Traffic Summary Window to Search the CATC Trace

You can use the Traffic Summary window to move the CATC Trace to packets of interest: 

1. Click one of the numbers in the right side of the Traffic Summary window. 

The CATC Trace jumps to the first instance of the selected protocol. 

2. Click the up or down arrows . The CATC Trace jumps forward or backward 
through the display to the next instance of selected protocol level.
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Traffic Summary  LeCroy Corporation

Traffic Summary Buttons

Buttons at the top of the Traffic Summary dialog provide options for exporting the data or 
formatting its appearance:

Save. Saves Traffic Summary results into an HTML format.

Email. Attaches an HTML file of the results to a new email.

Print. Prints results.

Text. Displays results in HTML format.

Options. Opens a drop‐down menu with the following options:

Grid Lines: Displays/Hides grid lines

Row Selection: Allows entire rows to be selected

Tight Columns: Reformats column widths to match data

Event Navigation: 

Skip Hidden Items

Show Hidden Items

Prompt each time
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Bus Utilization

Select Report > Bus Utilization from the menu or press to open the Bus Utilization 
window.

Figure 10.3: Bus Utilization Window

The Bus Utilization window displays information on bandwidth use for the transmit and 
receive channels.
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Bus Utilization  LeCroy Corporation

Bus Utilization Pop-up Menu

You can reformat the display by right‐clicking a graph and making a selection from the Bus 
Utilization pop‐up menu.

Go to Packet #: Relocates the CATC Trace to the selected packet number.

Undo Zoom: If you have zoomed in, this command undoes the zoom.

Zoom to Trace View: Zooms in on graph to show traffic currently displayed in the 
CATC Trace screen.

Fit to Graph Area: Redisplays graph so that the entire CATC Trace fits inside graph area.

Y Scale Type:

 Linear: Converts display to linear format
 Logarithmic: Converts display to logarithmic format

Hide: Hides the selected graph

Remove: Allows you to remove any graph that you created via the New command

Properties: Opens a dialog with options for changing the Title, Type, Appearance, and 
Color of the graphs.
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Figure 10.4: Graph Area Properties Dialog
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Bus Utilization  LeCroy Corporation

Bus Utilization Buttons

The Bus Utilization window buttons allow you to reformat the display and export data.

Button Function

Save. Saves Bus Utilization data to a bitmap file (*.bmp).

Email. Opens an email and attaches a bitmap file of the Bus 
Utilization data.

Print. Prints the Bus Utilization data.

Full Screen. Maximizes the Bus Utilization window.

View Settings. Opens a sub‐menu with the following choices:

• Orient Horizontally

• Tile Vertically

• Show Markers

• Show Plumbline

• Status >> 

• Bar

• Tool tips

• None

• Grid Lines >> 

• Both Axes

• X Axis

• Y Axis

• No Grid

• Grid on Top

• Fonts & Colors

Horizontal zoom in
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Horizontal zoom out

Vertical zoom in

Vertical zoom out

Click and Drag zoom. Click and drag to zoom in on a part of the 
graph.

Select Range. Displays a dialog for selecting a packet range.

Synchronize Graph Areas. If two or more graphs are displayed, this 
button synchronizes the graphs to one another. Once synchronized, 
the positioning slider of one graph moves the other graphs.

Graph Areas. Provides options for creating and displaying additional 
graphs of data lengths, packet lengths, and percentage of bus used. 
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Link Tracker  LeCroy Corporation

Link Tracker

The Link Tracker window displays a detailed chronological view of events. Events are 
shown on a channel‐by‐channel basis in columns within the window.

Figure 10.5: Link Tracker Window

Each time slot in the vertical axis represents the minimum time that a DWORD requires to 
traverse the bus. 

Toolbar: Presents buttons for changing the format of the Link Tracker window.

Main Display Area: Displays traffic chronologically as it occurred in the recording. The 
window divides into columns: the first column shows time and traffic is shown on a 
channel‐by‐channel basis in the columns on the right.
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Using the Link Tracker Window

The Link Tracker window can be reformatted in several ways.

Zooming In and Out

Zooming out can give you a quick, high‐level view of a CATC Trace. A fully zoomed out 
CATC Trace only shows columns and colored lines. Using the colors, you can see what 
types of traffic run through the CATC Trace. 

Further information can be obtained on any point of interest in the CATC Trace by 
positioning your mouse pointer over it. Tool tips provide detailed description of events. 

When fully zoomed out, the smallest graphical unit is the DWORD, represented by a 
single line. Zooming out makes the CATC Trace appear smaller and increases the time 
scale in the first column.
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Link Tracker  LeCroy Corporation

Collapsing Idle Time, Enabling Tool tips, and Resetting Column Widths

Click the View Options button to open a menu with options for formatting the 
display. Three options are presented:

Collapsible Idle Time: Opens a dialog box for setting the Idle time value. Setting a value 
tells the Analyzer when to collapse Idle times and display them as grayed out strips within 
the Bus View window. 

Tooltip Display: Opens a menu with options for adding content to Tooltips. Tooltips 
display when you position the mouse pointer over an item in the Bus View window. The 
options are:

 Tooltips Display Values
 Tooltips Display Scrambled Values
 Tooltips Display 10‐bit Codes
 Tooltips Display Symbols

Time Format: Seconds or Clock

Reset Column Widths: This option resets column widths to their defaults and enables 
columns to resize themselves automatically any time the application window is resized. 
Normally, columns automatically resize themselves if the application window is made 
larger or smaller. However, if you manually resize any columns in the Bus View window, 
column widths become static. Thereafter, if you resize the application window, the 
Bus View columns do not adjust automatically. Reset Column Widths re‐enables the 
automatic resizing capability.

Reset Columns Order: Return to default column sequence.

Docking and Undocking the Window

You can undock the Link Tracker window by double‐clicking the blue title bar along the 
left side of the window. Once undocked, the window can be dragged anywhere in the 
application. To redock, double‐click again on the title bar.
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Setting Markers

Markers can be set on any event within the Link Tracker window. 

To set a marker, right‐click an event, then select Set Marker from the pop‐up menu. 

Once marked, you can navigate to events with the Go to Marker command in the Search 
menu. 

Markers set in the Link Tracker window display the packet number and DWORD number. 
In contrast, markers set in the CATC Trace window just show the packet number.

Calculating Time between DWORDs

You can calculate time between DWORDs by clicking an event and then positioning your 
mouse pointer over a second event and reading the ensuing Tool tip.

Click the time value for the first event. Scroll down through the CATC Trace to the second 
event and position the mouse pointer above its time value. A Tool tip appears showing 
the time interval between the first and second events.

Hiding Traffic

You can hide Idles and other data from the Link Tracker window by clicking the Hide 
buttons on the toolbar.
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Link Tracker  LeCroy Corporation

Link Tracker Buttons

The Link Tracker window has a row of buttons for changing the format of the displayed data and for 
exporting data: The buttons have the following functions:

Full Screen. Expands the Link Tracker window to fill the entire screen.

View Options. Opens a menu with three options: 

• Collapsible Idle Time (Collapse Idle Bigger Than n nanoseconds. 
Note: Does not affect Collapse Idle Plus.)

• Tooltip Display (Values, Scrambled Values, 10‐bit Codes, Symbols)

• Time Format (Seconds, Clock)

• Reset Columns Widths (return to default widths)

• Reset Columns Order (return to default column sequence)

See “Using the Link Tracker Window” on page 136 for further details.

Synchronize Trace View. Synchronizes the Trace View and Link Tracker 
windows so that a move in one window repositions the other.

Because of the differences in scale and logic between the Link Tracker and 
Trace view window, scrolling produces different effects depending on which 
window is being scrolled. 

Scrolling in the CATC Trace window causes the Link Tracker window to 
rapidly jump from event to event. Long periods of idle time are thus 
skipped. 

Scrolling in the Link Tracker window, in contrast, produces modest 
movements within the CATC Trace window. 

Scrolling in the Link Tracker window causes the CATC Trace window to pause 
until the beginning of a packet is displayed. At that point, the CATC Trace 
window repositions itself. While scrolling long Idle periods or through the 
contents of a packet, the CATC Trace window does not move.

 

Zoom In

Zoom Out

Continuous Time Scale. No collapsing.

Collapse Idle. Do not show some periods of Link being idle.

Collapse Idle Plus. Do not show periods of Link being idle.
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Data Flow Window

The Data Flow window shows marker, packet, direction, type, length, address, payload, 
handshake, and timestamp information.

To obtain the Data Flow window, select Report > Data Flow 

or click the   Data Flow toolbar icon.

Figure 10.6: Data Flow Window

Show Values

Show Scrambled Values

Show 10b Codes

Show Symbols

Show Text
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Data Flow Window  LeCroy Corporation

The toolbar allows you to:

 Expand the window to full screen or Collapse to a smaller window.
 Synchronize.
 Save.
 Select Data Flow columns to display and their widths: 

 Marker
 Packet
 Direction
 Type
 Length
 Address
 Payload
 Handshake
 Time Stamp

Figure 10.7: Data Flow Columns Dialog
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Using the CATC Trace Navigator

The CATC Trace Navigator is a tool for navigating within the CATC Trace. It allows you to 
view the location of errors and triggers in a CATC Trace and to narrow the range of traffic 
on display. It also allows you to quickly jump to any point in the CATC Trace.

Displaying the Navigator

Click in the toolbar to display the Navigator. The Navigator appears on the right side 
of the Main window. It has a two‐button toolbar and a vertical slider bar. It also has 
colored panes for navigating the CATC Trace in different ways. You set which panes are 
displayed through Navigator pop‐up menus.

Figure 10.8: Navigator Dialog
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Using the CATC Trace Navigator  LeCroy Corporation

Navigator Toolbar

The Navigator toolbar lets you quickly set Navigator features. The toolbar has two 
buttons.

Navigator Ranges: This button brings up a pop‐up menu that lets you reset the Navigator 
range. The range determines what packets are viewable in the CATC Trace display.

Navigator Panes: This button has two purposes: To select which Navigator panes appear 
and to bring up the Navigator legend. The legend determines how information is shown in 
the panes.

Navigator Ranges

You set the viewing range by dragging the yellow range delimiters along the slider. To set 
the lowest packet viewable, drag the top delimiter up. As you do so, a tool tip appears to 
indicate the current range. Stop dragging when you reach the desired lowest packet. 

To set the highest packet viewable, drag the bottom delimiter down. Stop when the tool 
tip indicates you are at the desired highest packet.

.
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To Determine Current Position

In addition to the two range delimiters, the slider has a blue current‐position indicator 
(see above). The current‐position indicator shows where you are in the CATC Trace 
display with respect to the possible viewing range. 

For example, suppose you set viewing range to packet 0 through packet 500 (the top 
range delimiter is at packet 0, and the bottom range delimiter is at packet 500). If you 
then move the current‐position indicator on the slider to midway between the top and 
bottom delimiters, then packet 250 appears in the middle of the CATC Trace display. 

To Reset Navigator Range

You can reset the Navigator range using the toolbar Navigator Range button. Press the 
button to bring up the Navigator Range drop‐down menu.

The menu has the following options:

 Set Range to Whole Trace: Allows you to reset the range to include the entire 
CATC Trace file contents. The top range delimiter is placed at the lowest packet 
number in the CATC Trace. The bottom range delimiter is placed at the highest 
packet number in the CATC Trace.

 Set Range Near Packet xxx: Allows you to collapse the range so that only the 
packets immediately above and below the xxx packet are displayed. The xxx 
packet is whatever packet is currently at the top in the CATC Trace display.

 Recently Used Ranges: Allows you to reset the range to any of a number of 
recently used (previously set) ranges. 



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 145

Using the CATC Trace Navigator  LeCroy Corporation

Navigator Panes

You can display any combination of CATC Trace Navigator panes.

From left to right, the panes are: Pre/Post Trigger, Errors, Traffic Type, Traffic Speed, and 
Link Width. Each pane represents the entire CATC Trace with respect to different types of 
information. The top of each pane represents the start of the CATC Trace file, and the 
bottom represents the end of the CATC Trace file.

 Pre/Post Trigger: To view the trigger event in the CATC Trace and the relative size 
of pre‐trigger and post‐trigger portions of the CATC Trace. The two portions are 
set apart as different colors. The trigger event occurs at the point the two colors 
meet.

 Errors: To view any errors in the CATC Trace. A thin red line represents each error 
in the pane.

 Traffic Type: To view the types of packets that occur in the CATC Trace. A differ‐
ent color represents each packet type in the pane. The relative size of colored 
portions in the pane corresponds to the amounts of the various packet types in 
the CATC Trace. As described below, you can use the Navigator legend to change 
the types of packets that take precedence in the display.

 Traffic Speed: To view the speed that occurs in the CATC Trace. 
 Link Width: To view the link width that occurs in the CATC Trace. 

To Show/Hide Navigator Panes

You can show/hide any of the panes using pop‐up menus accessible through left‐click the 
Navigator Panes button or by right‐click anywhere in any CATC Trace Navigator pane.



LeCroy Corporation Using the CATC Trace Navigator

146 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual

Navigator Slider

The Navigator slider appears at the left of Navigator panes. The slider has yellow upper 
and lower range delimiters and a blue current‐position indicator.

The Navigator slider lets you to set the range of packets viewable in the CATC Trace 
display. In other words, it sets scrolling range of the display. You can scroll the display up 
to the lowest packet number in the viewing range. You can scroll the display down to the 
highest packet number in the viewing range.

CATC Trace Navigator Legend

The Navigator legend lets you control the display of content in Navigator panes.

You bring up the legend through the Navigator Pane’s drop‐down menu. Press the toolbar 
Navigator Panes button to access the menu. Select the Legend option to bring up the 
Navigator Legend dialog.

Figure 10.9: Navigator Pane and Navigator Legend Dialog

The Navigator Legend dialog has areas corresponding to each of the panes. Each area has 
check boxes that allow you to hide/display information in the pane. You can set the 
priority of information displayed in the panes using the up and down triangles on the 
right.

Using the Legend to Show/Hide Navigator Panes

To use the legend to show/hide an entire pane, use the checkbox next to the name of 
each pane in the legend. 

In the case of the Pre/Post Trigger and Errors areas, the action of show/hide in the legend 
is identical to that provided by CATC Trace Navigator pop‐up menus. 

In the case of the Traffic Types pane, there is no equivalent show/hide available through 
the pop‐up menus.



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 147

Using the CATC Trace Navigator  LeCroy Corporation

Using the Legend to Set the Priority of Information Display

You can use the legend to set the priority of information displayed in the Pre/Post Trigger 
Traffic Type panes. This is a two‐step process. 

1. For a particular item in a pane, click the column next to the checkbox for the item. 
That labels the item as currently active. 

2. Next, use the up‐down at the lower‐right of the area to move the item higher or 
lower in priority.

In the case of the Traffic Type pane, priority determines display priority of each packet 
type. For portions of the CATC Trace that are dominated by a particular packet type, this 
setting no effect: only the color corresponding to that packet type is displayed in that 
portion of the pane. Suppose, however, that part of the CATC Trace includes equal or near 
equal numbers of several types of packets. In that case, you can use the legend to select 
which among those types is represented in that portion of the Traffic Types pane. This 
allows you to view only packets of interest in crowded portions of the CATC Trace display.
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LTSSM Flow Graph

The LTSSM Flow Graph shows link state transitions that the link goes through, as recorded 
in the CATC Trace file. To obtain the LTSSM Flow Graph, select View > LTSSM Flow Graph.

Figure 10.10: LTSSM Flow Graph Dialog

You can display the following directions: 

 Upstream
 Downstream
 Both

You can Show Number of Transitions.

Click the blue button (on the Recovery state below) to see the substate.
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Packet Header Bar

The Packet Header bar shows packet header information.

To obtain the Packet Header bar, select Report > Packet Header 

or click the   Packet Header toolbar icon.

Figure 10.11: Packet Header Bar

The toolbar allows you to Save, go to Previous or Next, display Hexadecimal or Binary, and 
show the Packet Data window.

Packet Data Window

The Packet Data window shows packet information.

To obtain the Packet Data window, select Report > Packet Data 
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or click the   toolbar icon. 

Figure 10.12: Packet Data Window

The toolbar allows you to Save; go to Previous or Next; display Hexadecimal, ASCII, 
Decimal, or Binary; use MSB Format or LSB Format; and use Big Endian or Little Endian.

Format and Columns allows you to enter the number of bytes, words, or dwords per line.

You can enter an Offset and scroll to it.

You can enter text and Search Previous or Search Next.

Configuration Space View

The Configuration Space View displays information about the Configuration Space state 
as of the current packet of the currently selected device. The view shows the 
Configuration Space Header and the PCI‐compatible or PCI Express Capability Structures.
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To display the Configuration Space View for a device at a packet:

1. Open a CATC Trace, such as the sample file cfg_pci_express.pex.

2. Scroll to a packet with a Configuration header.

3. Select Report > Configuration Space > <device> to display the Configuration Space 
View.

or

Click a CompleterID or DeviceID field. A pop‐up menu opens.
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Select Show Configuration Space for xxxx from the menu, where xxxx is the device 
number. The Configuration Space View opens.

Figure 10.13: Configuration Space View

On the left, the view displays the Configuration Space for the selected CompleterID or 
DeviceID at the current packet. You can select Configuration Space Header or a 
Capability Structure. 

The right displays the decoded data of the selected Configuration Space Header or a 
Capability Structure, up to the current packet. (The decoding builds while navigating 
through the next packets.)

The Configuration Space View toolbar allows you to Save, go to First, go to Previous, 
go to Next, go to Last, go to Previous Access to Selected Configuration Space Register, 
go to Next Access to Selected Configuration Space Register, and display Hexadecimal or 
Binary.

Note:See Appendix A “Configuration Space Decoding” on page 167.



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 153

Using Unit Metrics  LeCroy Corporation

Using Unit Metrics

For every protocol unit at the Link or Split transaction level, PETracer™ calculates and 
displays a set of metrics. Metrics are measurements of key operating parameters. You can 
use metrics to evaluate performance of traffic in the CATC Trace stream. 

You can view metrics information in the CATC Trace display, the Traffic Summary window, 
and the Bus Utilization window. 

PETracer defines different metrics for Link and Split transactions.

Metrics Defined for Link Transactions
 Number of Packets: The total number of packets that compose this Link transac‐

tion.
 Payload: The number of data payload bytes this Link transaction transferred.
 Response Time: The time it took to transmit this Link transaction on the PE link, 

from the beginning of the first packet in the transaction to the end of the last 
packet in the transaction.

 Data Throughput: The payload divided by response time, expressed in mega‐
bytes per second.

Note:Usually, the Number of Packets metric for a link transaction is two (in case of explicit 
acknowledge) or one (in case of implicit acknowledge). However if Naks/link level retries are 
involved, this metric might be higher. As a result, the Number of Packets metric is useful in 
highlighting unusual link transactions.

Metrics Defined for Split Transactions

The following types of metrics currently are defined for Split transactions:

Number of Link Transactions: The total number of Link transactions that compose this 
Split transaction.

Payload: The number of payload bytes this Split transaction transferred.

Response Time: The time it took to transmit this Split transaction on the PE link, from the 
beginning of the first packet in the Split transaction to the end of the last packet in the 
Split transaction;

Data Throughput: The transaction payload divided by response time, expressed in 
megabytes per second.

Latency Time: The time measured from the end of the request transaction to the first 
completion transmitted in response to the request within this Split transaction.

Note:The Number Of Link Transactions metric for a Split Transaction usually is two for a Configuration 
or IO request. It can be bigger then two for a Memory Read request.
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Show Metrics in the CATC Trace Display

In the CATC Trace view display of Link Transaction or Split Transaction levels, all metrics 
information applicable to a specific protocol unit is displayed in a Metrics header. The 
header is located close to the end of the unit, in front of the Time cell. You can expand 
and collapse the header to show or hide the metrics information.

Collapsed Metrics Header Display

Following is a collapsed metrics display for a unit of Link Transaction. The collapsed 
header display shows only the metrics cell representing the Number of Packets.

Following is a collapsed metrics display for a unit of Split Transaction. The collapsed 
header display shows only the metrics cell representing Number of Link Transactions.

Metrics Tool Tip Display

In both CATC Trace level views, you can view the summary of all the unit metrics in the 
Metrics header tool tip. To view the tool tip, simply place the mouse cursor over the 
Metrics header. Following is the tool tip for a unit in the Link Transaction view.

Note:The tool tip also presents information for time passed from the start of the recording till the 
beginning of this Link or Split Transaction.
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Expanded Metrics Header Display

When you expand the Metrics header, the display creates a separate cell for each 
applicable metric:

The following is the expanded Metric header for a unit in the Split Transaction view.

The following is the expanded Metric header for a unit in the Link Transaction view.

Note:Each of the metric cells pops up a tool tip window with the explanation of what the metric 
means.

Show Metrics in the Traffic Summary Window

Some of the Traffic Summary reports at the Link and Split Transaction levels are based on 
metrics collected for the corresponding protocol units in the CATC Trace.

Reports at Split Transaction Level

Split Transaction Performance: This report table groups the Split Transactions by 
Requester‐Completer pair and displays Minimum/Average/Maximum data for Number Of 
Link Transactions and Response Time metrics.
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Read Requests Performance: This report table includes only the Split Transactions that 
present Read Requests (Configuration, IO and Memory). It groups them by the 
combination of Requester‐Completer pair, request type, and Traffic Class and displays 
Minimum/Average/Maximum data for Throughput, Response Time, and Latency metrics.

Write Requests Performance: This report table includes only the Split Transactions that 
present Write Requests (Configuration and IO). It groups them by the combination of 
Requester‐Completer pair, request type, and Traffic Class and displays Minimum/
Average/Maximum data for Throughput, Response Time, and Latency metrics.

Reports at the Link Transaction Level

The following metric‐based reports are displayed at the Link Transaction level:

Link Transaction Performance: This report table groups the Link Transactions by TLP Type 
and displays Minimum/Average/Maximum data for Number Of Packets, Response Time 
and Payload Bytes metrics.
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Memory Writes: This report table includes only the Link Transactions that present 
Memory Write Requests. Memory Writes are the only (posted) requests that don't get 
promoted to the Split transaction level, therefore their performance should be viewed at 
the Link transaction level. The table groups Memory Writes by the combination of 
Requester ID and Traffic Class and displays Minimum/Average/Maximum data for 
Response Time, Payload and Throughput metrics.

The following features apply to all of the report tables described above for the Split 
Transaction and Link Transaction levels:

 Each report row for the defined tables contains the total number of units in this 
group for the CATC Trace (total number of units for Split Transaction perfor‐
mance, Read Requests performance, Memory Writes, and so on).

 In many cases, the Maximum and Minimum values in the report tables are navi‐
gable. By clicking table cells, you reposition the corresponding CATC Trace view 
to the Split or Link Transaction that has yielded this maximum or minimum value. 
This can help you to find specific units in the CATC Trace, such as transactions 
that produced spikes in Response Time or Throughput.

Show Metrics in the Bus Utilization Window

The Bus Utilization window provides graphs for packet‐level information in the 
CATC Trace. The window also provides graphs for information on Split and Link 
Transaction levels, plotted over time. The graphs for Split and Link Transaction levels are 
based on metrics collected for the transactions throughout the CATC Trace.

The seven graphs related to Split and Transaction levels are:

1. Pending Requests at Split Transaction level.

2. Response Time at Split Transaction level.

3. Latency Time at Split Transaction level.

4. Throughput Per Transaction at Split Transaction level.

5. Response Time and Latency Time at Split Transaction level (combined graph).

6. Response Time at Link Transaction level, for Memory Writes only.

7. Throughput at Link Transaction level, for Memory Writes only.
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The following is an example of Bus Utilization window display of graph numbers 1, 4, 5, 6 
and 7:

Unit-Based Averaging

The Analyzer builds metric graphs using unit‐based averaging (as opposed to time‐based 
averaging). For the total duration of a certain request (or Memory Write transaction), the 
graph value is assumed equal to the corresponding metric for this request (transaction). If 
there are overlapping operations for a certain time period, then the value is calculated as 
an average of metric values for all the overlapped requests (transactions).

It is important to remember that the Analyzer uses unit‐based averaging rather than 
time‐based averaging. Time‐based averaging can be misleading in some situations. For 
example, consider the Throughput Per Transaction graph. Sometimes, while many 
outstanding requests are in progress, latency (and response time) grows for each of the 
transactions, resulting in a lower throughput per transaction over time (which is reflected 
in the graph). This happens even though aggregated throughput across all the 
transactions is constant.
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Bus Utilization Window Features

For the seven Split‐ and Transaction‐level graphs listed, all Bus Utilization window 
features are available, such as zooming in/out, changing scale type, scrolling, context‐
sensitive status, and graph synchronization. See Bus Utilization and Bus Utilization 
Buttons for more on these features.

Note:Clicking a certain place within a graph area repositions the CATC Trace display at the Link or Split 
transaction level to the transaction that was in progress at that time.

Split Transaction Level Graphs

Transactions at the Split level combine all the non‐posted requests with corresponding 
completions. This includes Configuration and IO Read and Write requests, as well as 
Memory Read requests.

The following shows the graphs for the Split level:

Note:The Pending Requests graph is not directly defined by metrics, but it is useful when considering 
metrics. The Pending Requests graph presents the unit‐averaged number of requests that were 
pending (in progress) at any moment of time. It allows you to correlate the number of requests 
posted to a completer with other performance metrics.
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Link Transaction Level Graphs

Memory Writes are the only (posted) requests that do not get promoted to the Split 
transaction level. Therefore, Memory Write performance should be viewed at the Link 
Transaction level. That is the reason graphs at the Link level only present the Memory 
Write‐related metrics and are titled Writes: Response Time: and Writes: Throughput.

TC to VC Mapping

TC to VC Mapping displays how Traffic Classes are mapped to Virtual Channels (to 
simplify navigation) and how the CATC Trace display was changed (for example, in Split 
Transactions).

Figure 10.14: TC to VC Mapping Dialog
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Timing and Bus Usage Calculations

The Timing and Bus Usage Calculator allows you to calculate time between packets.

Select Reports > Timing Calculations to obtain the Timing Calculator dialog.

Figure 10.15: Timing Calculator Dialog

Total Time: Total time from beginning of the first unit to beginning of the second unit.
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Bus Utilization

This portion of the Timing Calculator window gives values that are cumulative for all 
packets during the timing period. For example, throughput is combined throughput of all 
packets during the timing period.

Upstream is from endpoint devices to the root complex. Downstream is from the root 
complex to endpoint devices.

Link Utilization: Percentage of non‐idle symbols in total number of symbols transferred.

Time Coverage: Percentage of non‐idle symbol times in total number of symbol times. 
(Non‐idle symbol time occurs when at least on one of the lanes there were non‐idle 
symbols transferred.)

Bandwidth: Number of non‐idle symbol bits transferred per second.

Data Throughput: Number of TLP payload bytes transferred per second.

Packets/second: Number of packets transferred per second.

Split Transaction Performance

This portion of the Timing Calculator window gives minimum, maximum, and average 
values for all Split transactions during the timing period. For example, minimum 
throughput is throughput of the Split transaction that passes the least amount of data. 
Maximum throughput is throughput of the Split transaction that passes the most amount 
of data. Average throughput is the average calculated for all Split transactions during the 
timing period.

Response Time: The time it took to transmit this Split transaction on the PE link, from the 
beginning of the first packet in the Split transaction to the end of the last packet in the 
Split transaction.

Latency: The time measured from the end of the request transaction to the first 
completion transmitted in response to the request within this Split transaction.

Throughput: The transaction payload divided by response time, expressed in megabytes 
per second.

Memory Writes Performance

This portion of the Timing Calculator window gives minimum, maximum, and average 
values for all Memory Write transactions during the timing period. For example, 
minimum throughput is throughput of the Memory Write transaction that passes the 
least amount of data. Maximum throughput is throughput of the Memory Write 
transaction that passes the most amount of data. Average throughput is the average 
calculated for all Memory Write transactions during the timing period.

Response Time: The time it took to transmit this Memory Write on the PE link, from the 
beginning of the first packet in the Memory Write to the end of the last packet in the 
Memory Write.

Throughput: The Memory Write payload divided by response time, expressed in 
megabytes per second.
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Running Verification Scripts

You can run verification scripts to check errors, link transactions, split transactions, 
metrics, ordered sets, replays, DLLPs, and TLPs.

To obtain the Verification Script dialog, select Tools > Run verification scripts

or click the   icon.

Figure 10.16: Verification Scripts Dialog

The available verification scripts are in the Verification script section.

To run a script, select it, then click the Run Scripts button  .

The results appear in the bottom window. You can expand or collapse this window. You 
find a view related to the CATC Trace and place this window under or to the right of it. You 
can Save the results.

Click the Settings button to display the Settings Dialog.
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Figure 10.17: Settings Dialog

You can choose the editor, display settings, and saving settings.
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Chapter 11

Updates and Licensing

Updating the Analyzer

BusEngine™ and/or Firmware updates are now automatic processes that run anytime a 
new version of the PETracer™ software is installed that is incompatible with the currently 
installed BusEngine or Firmware. The update process generates onscreen instructions.

If, however, you need to manually perform BusEngine or Firmware updates, follow these 
steps:

1. Select Setup > Update Device … from the menu to display the Update Analyzer 
dialog box for Summit T28™. 

2. Select the appropriate file locations for the Firmware and/or BusEngine, using 
Browse, if necessary. 

3. Check the appropriate options (if in doubt, check all options).

4. Click Update to initiate the updating of the Analyzer.

License Keys

A License Key is necessary to enable software maintenance. If you attempt to record with 
the Analyzer without an installed License Key, a message appears to indicate that a License 
Key is necessary in order to record traffic.

A License Key must be obtained from LeCroy for each Analyzer.

After you obtain the License Key, follow these steps to install it:

1. Select Setup > All Connected Devices and click the Update License button to display 
the Select License Key File dialog box.

2. Enter the path and filename for the License Key or use the Browse button to 
navigate to the directory that contains the License Key. 

3. Select the .lic file, and then click Open.

License Information

You can view Licensing information for your Analyzer by selecting Help > Display License 
Information... from the menu bar. The License Information window displays data about 
the maintenance expiration and purchased features. 
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Appendix A

Configuration Space Decoding

The decoded capability structures in the Configuration Space Viewer and Editor are based 
on programmed definitions in the PETracer software and on Configuration Space Decode 
Scripts.

Configuration Space Decode Scripts are tools to define capability structures and instruct 
the Configuration Space Viewer or Editor how to decode them. These scripts are in the 
\CfgSpaceScripts sub‐directory below the \Scripts directory in the application directory.

You can write Configuration Space Decode Scripts using the CATC Scripting Language (CSL). 
See the LeCroy Analyzers File Based Decoding Manual for reference.

PCI Express Configuration Space Decode Scripts have the file extension .pecfgdec.

Mandatory Definitions

Configuration Space Decode Scripts must set the following reserved variables.

 CapabilityName: Name of the capability structure
 CapabilityID: ID of the capability structure
 ExtAddSpace: Set to 1 if Extended Configuration Space. Else, set to 0 for PCI.

  

Mandatory Module Functions

Modules are collections of functions and data dedicated to decoding a specific capability 
structure. Each module has one primary Configuration Space Decode Script file 
(extension .pecfgdec) and optionally has include files (.inc).

A module function is an entry‐point into a decoding module. To help display a 
capability structure, the application calls a module function.

The Configuration Space Editor and Viewer support only the DecodeRegister(offset) and 
GetSize( ) functions.
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DecodeRegister(offset)

The application calls this function while decoding a specific DWORD offset of the 
specified CapabilityID. The offset is the decoding entry point, where the decoding path 
starts. 

The Configuration Space Editor calls this function to determine how to decode the 
assigned configuration space. The offset parameter is the DWORD to decode. 
An offset of 0 indicates bytes 00h‐03h, an offset of 1 indicates bytes 04h‐07h, and so on.

Note:The Configuration Space Editor can only decode one DWORD at a time.

GetSize()

This function returns the size of the capability structure specified by CapabilityID.

Configuration Register Types

The following reserved variables are defined global constants.

 CFGREG_UNDEFINED
 CFGREG_HWINIT
 CFGREG_RO
 CFGREG_RW
 CFGREG_RW1C
 CFGREG_ROS
 CFGREG_RWS
 CFGREG_RW1CS
 CFGREG_RSVDP
 CFGREG_RSVDZ

Note:These reserved variables match the Configuration Register Types of Table 7‐2 in Section 7.4 of 
the PCI Express Base Specification, Rev. 2.1.
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Primitives

Decoding uses the following primitives.

GetRegisterField(dword_offset, bit_offset, field_length)

This function returns a register field of length field_length, starting at bit position 
bit_offset in DWORD dword_offset.

 dword_offset: DWORD offset of the register field location
 bit_offset: Bit offset of the register field location
 field_length: Length of the register field

For example, GetRegisterField(1, 9, 2); means: Go to DWORD 1, bit offset 9, and returns 2 
bits.

AddField(field_name, field_length, configuration_reg_type, tooltip, encoding_table = 
NULL)

This function adds a register field to the Capability View and returns a pointer to the field, 
for adding subfields.

 field_name: Name of the register field to display in the Capability View
 field_length: Length of the register field
 configuration_reg_type: Configuration register type of the register field. 

Note: If subfields are defined, their configuration register types override this set‐
ting for their specified bits.

 tooltip: Tooltip displayed for the register field in the Capability View
 encoding_table: Optional. Displays encodings as lists for select values.
 For example, user input becomes a combo box for the field in the Field View.

As examples: 
AddField("PCI Express Extended Capability ID", 16, CFGREG_RO, "");
means: Add the field “PCI Express Extended Capability ID” with length 16 and cfg register 
type CFGREG_RO.

capability_reg = AddField("Capability Register", 32, CFGREG_RW, "");
means: Added the field “Capability Register” with length 32 and cfg register type 
CFGREG_RW and stored a pointer to this field in variable capability_reg, which can be 
used to add subfields to this field.
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AddSubField(parent_field, subfield_name, subfield_length, configuration_reg_type, 
tooltip, encoding_table = NULL);

This function adds a subfield to a register field in the Capability View. Subfields are 
modifiable and visible in the Field View and appear in the tooltips of register fields.

 parent_field: Pointer to a register field in the Capability View
 subfield_name: Name of the subfield, displayed in the Field View
 subfield_length: Length of the subfield
 configuration_reg_type: Configuration register type of the subfield field. 

Note: This overrides the configuration_reg_type of the parent field.
 tooltip: Tooltip displayed for the subfield in the Capability View
 encoding_table: Optional. Displays encodings as lists for select values.
 For example, user input becomes a combo box for the field in the Field View.

For example, 
AddSubField(capability_reg, "Mode Supported", 4, CFGREG_RO, "Indicates the 
Function modes," ), ModeEncodings);
means: Add the subfield “Mode Supported” to the parent field “capability_reg” with 
length 4, type CFGREG_RO, a tooltip in the Capability View, and a combo box displaying 
“mode encodings” for input in the Field View.

Helper File

ConfigSpaceCommon.inc include file contains useful functions for script decoding.
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China Restriction of Hazardous Substances Table  LeCroy Corporation

China Restriction of Hazardous Substances Table
The following tables are supplied in compliance with China’s Restriction of Hazardous 
Substances (China RoHS) requirements: 



LeCroy Corporation China Restriction of Hazardous Substances Table

172 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual



 Summit T28 PCI Express Multi‐Lane Protocol Analyzer User Manual 173

Appendix B

How to Contact LeCroy

Type of Service Contact

Call for technical support US and Canada: 1 (800) 909‐7112

Worldwide: 1 (408) 653‐1260

Fax your questions Worldwide: 1 (408) 727‐6622

Write a letter LeCroy

Protocol Solutions Group
Customer Support
3385 Scott Blvd.

Santa Clara, CA 95054‐3115

USA

Send e‐mail psgsupport@lecroy.com

Visit LeCroy’s web site http://www.lecroy.com/
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